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On-line Installation Help
Version 5.0 (October 18, 2000)

CGTech on-line Help works best with Internet Explorer 5.0 or higher, or Netscape 4.75 or higher.

Prior to installing any software, we recommend that you review the system requirements and the
installation procedure for the computer type on which you intend to operate VERICUT: Windows or
UNIX. Follow all applicable steps to ensure smooth VERICUT installation and successful operation.

5.0 LICENSING IS REQUIRED - Use only 5.0 licensing with this software. Licensing is sent only via
Email. See "Introduction to installing VERICUT" for details.

<= Use Contents/Index/Search tabs, or click on a topic below:

� 5.0 System Requirements

� Introduction to installing VERICUT

� Install VERICUT on: Windows, UNIX

� ERRORS and Problem Solving

� CGTech On-line Help Library

 

Tip: Once in VERICUT, press "F1" in any VERICUT window to receive help on that window.

Copyright information

Copyright © 2000 CGTech. All Rights Reserved. User documentation from CGTech is subject to copyright laws of the United States
and other countries and is provided under a license agreement, which restricts copying, disclosure, and use of such documentation.
CGTech hereby grants to the licensed user the right to make copies in printed form of CGTech user documentation provided on
software or documentation media, but only for internal, noncommercial use by the licensed user in accordance with the license
agreement under which the applicable software and documentation are licensed. Any copy made hereunder shall include the CGTech
copyright notice and any other proprietary notice provided by CGTech. User documentation may not be disclosed, transferred, or
modified without the prior written consent of CGTech and no authorization is granted to make copies for such purposes.

Information described in this document is furnished for general information only, is subject to change without notice, and should not
be construed as a warranty or commitment by CGTech. CGTech assumes no responsibility or liability for any errors or inaccuracies
that may appear in this manual.

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary
information, and is protected by the copyright laws of the United States and other countries. UNAUTHORIZED USE OF
SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION.

Registered Trademarks of CGTech: VERICUT, OptiPath, and RevPost.

Trademarks of CGTech: AUTO-DIFF, CATV, FastMill, PolyFix, and X-Caliper.

CGTech  9000 Research Drive, Irvine, CA 92618 • www.cgtech.com • Tel: (949) 753-1050 • Fax: (949) 753-1053 • Email:
support@cgtech.com
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Chapter 1  Introduction

Introduction to installing VERICUT

In most cases installing VERICUT is a straight-forward and easy task, requiring only a few minutes of
time. Prior to installing any software, review the system requirements and the installation procedure for the
computer type (Windows or UNIX) on which you intend to operate VERICUT. Follow all applicable steps
to ensure smooth VERICUT installation and successful operation.

Installation overview

Following is an overview of the installation process. Exact steps vary based on computer type, and can be
found the Installation section for your computer type.

1. Verify that the computer meets or exceeds all system requirements.

2. Complete the pre-installation procedure on each computer to run VERICUT.

3. Install VERICUT on the CGTech license server computer.

4. License software for use and start the CGTech license server (not applicable to "Demo" license
servers)

5. Configure floating network clients, if any, to access VERICUT.

6. (Optional) Configure an older version of VERICUT to run concurrently with the installed version.

Licensing

5.0 licensing is required to use VERICUT. Pre-5.0 licensing is incompatible with the 5.0 CGTech Network
License Server. VERICUT may be installed, but cannot be run without a license. Obtain licensing from
CGTech as described below.

� Existing customers— Complete and return the License Request Form in the CD booklet, or
submit the application at www.cgtech.com/license.

� New customers— First determine your machine ID as described in the pre-installation procedure
for your computer type: Windows or UNIX. Then complete and return the License Request Form
in the CD booklet, or submit the application at www.cgtech.com/license.

 

See how to install VERICUT on Windows or UNIX.
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About CGTech documentation

CGTech provides documentation in the following forms:

� HTML books

� PDF books

All books are available in HTML and PDF formats on the CGTech CD-ROM. You can view HTML books
with your Internet browser. To view and print PDF books, you must have the Acrobat Reader installed.

Note: Printed documentation is available from CGTech at extra cost. Please contact your CGTech
representative for more information.

CGTech welcomes your suggestions and comments on its documentation. You can send feedback in the
following ways:

� Send comments electronically to support@cgtech.com, or via the CGTech web site at
www.cgtech.com.

� Fax comments to CGTech, attention: Documentation Department at (949) 753-1053.

Conventions

CGTech documentation uses the conventions described in this section.

Fonts

The table below describes text fonts used to help orient the user to the CGTech product user interfaces, and
actions.

Font type Where used Examples

Bold Menus paths, dialog box options,
buttons, and other user interface
elements.

Choose File menu > Save.

Choose Model Type=Fixture.

Italics Names of other CGTech
documents, system messages, file
names.

For more information, consult the
VERICUT Installation
documentation.

When done, you will see a
message similar to Processing
complete.

Less-than and greater-than
symbols (< >)

Variables for which the user
substitutes an appropriate value.

Enter File=<yourname.usr>

PPRINT/VERICUT-CUTCOLOR
<n>

Coordinate systems and angles

CGTech products use a right-hand Cartesian coordinate system to describe location and orientation.
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Rotation angle values are specified in decimal degrees. A positive angle goes counter-clockwise about an
axis when viewed from the positive end of the axis, looking towards the origin. A negative angle specifies
clockwise rotation as shown in the next figure.

See how to install VERICUT on Windows or UNIX.
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Chapter 2  System Requirements

VERICUT 5.0 System Requirements

IMPORTANT! Review carefully before installing any software.

General requirements for all VERICUT systems

� CD-ROM drive (required for installation only)

� Two or three button mouse

� Network interface card (Token Ring also supported)

� Graphics device capable of displaying at least 256 colors (True color is recommended)

Note: Multiple processors are recommended.

Disk space: 180 Mb

RAM: 256 Mb (512+Mb recommended)

Swap space ("Page file"): 2x RAM; Microsoft recommends Windows be
allowed to dynamically manage Page file size.

Temporary space: 30-90 Mb; users must have write access to the
directory containing temporary files:

Windows- stored as directed by the TMP
environment variable or in "C:\"

UNIX- stored as directed by TMPDIR environment
variable (if defined) or in "/usr/tmp" or "/tmp"

 

Windows system requirements

Windows NT NT 4.0 SP4, Intel Pentium-500mhz or better

Windows 2000 Intel Pentium-500mhz or better

Windows 95-98 Intel Pentium-500mhz or better

 

UNIX system requirements

HP HP-UX 11.0 or later
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IBM AIX 4.3.3 or later

SGI IRIX 6.5 or later; MIPS R5000 processor or higher

Sun/Solaris Solaris 2.6.1 or later

 

Java Runtime Environment (JRE)

JRE is automatically installed on Windows. UNIX systems must have JRE installed prior to installing
VERICUT.

HP Java RTE v1.2.2.05 dated August 2000

IBM Java J2RE 1.2.2 IBM build ca122-20000915

SGI Java_eoe v1.2.2 dated 04/28/00

Sun/Solaris Java 2 Runtime Environment v 1.2.2_005a

If you do not have JRE installed on your UNIX system, consult your hardware vendor's website for the
latest information (e.g.: www.hp.com, www.ibm.com, www.sgi.com, www.sun.com). Following are known
vendor JRE site locations, as of September 30, 2000:

� HP - www.unixsolutions.hp.com/products/java

� IBM - www.ibm.com/java/jdk/aix

� SGI- www.sgi.com/developers/devtools/languages/java2_122.html

� Solaris - jsp2.java.sun.com/products/jdk/1.2/jre

 

Continue with the pre-installation procedure for Windows or UNIX.
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Chapter 3  Installation
Install on a Windows Computer

Pre-installation procedure for Windows computers

On Windows NT and 2000 CGTech recommends that you install software as "Administrator", but this is
not a requirement (does not apply to Windows 95-98.)

BEFORE YOU BEGIN - Verify that all system requirements are met. Consult the System Requirements
section and ensure that computers to run VERICUT meet or exceed requirements for devices, disk space,
memory, operating system, etc.

 

1. Set optimum color display for VERICUT

True color display provides optimum VERICUT performance. Desktop display is changed via the
Display function in the Control Panel.

Reseller Demo licenses skip the remaining steps in this section. Go to "Install on a Windows license server
computer".

2. Check for required network software

Verify that the required network software components are installed and functioning. (See how)

3. Identify the machine ID for licensing

Insert the CD into the license computer’s CD drive. Cancel from the install screen (if required)
and double-click on the ‘lmtools.exe’ file located in the CD’s top level directory. Your Host ID
is the "Ethernet Address" on the System Settings tab of the Lmtools window.

To identify the machine ID without using the CGTech CD, see "Identify a Windows computer
machine ID" later in this chapter.

- If you already have licensing for this version— Verify that the machine ID shown in your
licensing matches that of the computer to be the CGTech license server. If they are different
contact the CGTech Licensing Department for assistance.

- If you DO NOT have licensing for this version— Complete and return the License Request Form
in the CD booklet, or submit the application at www.cgtech.com/license.

Ignore the next step if you are running VERICUT only on the computer on which you are installing.

4. Verify clients can communicate with the CGTech license server

If you are installing VERICUT in a floating network with multiple clients, all VERICUT
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computers must be able to communicate with each other over the network. Each computer must
have a hostname assigned and appropriate entry in a network file, for example:

Windows 95-98 => C:\windows\hosts

Windows NT/2000 => C:\winnt\system32\drivers\etc\hosts

Typically VERICUT is installed using the license server computer on a network accessible disk or
file system. The installation program assumes the installing computer is the license server, but
this can be changed during installation.

Continue with "Install on a Windows license server computer"
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Install VERICUT on a Windows CGTech license server computer

Follow the procedure below to install VERICUT on the computer to be the CGTech license server (as
identified in the CGTech-supplied licensing).

 

1. Complete the pre-installation procedure for Windows computers

2. Insert the CD and run the Windows installation program

If your computer does not automatically start the installation program, run the “SETUP.EXE”
program on the CD. The installation program will guide you through the install process.

- If you are prompted for a machine Hostname, be sure to enter the Hostname of the CGTech
license server machine.

3. Create a license file from the emailed licensing received from CGTech

Use the correct licensing for this version of software-see the Introduction for details and
instructions on how to obtain licensing from CGTech. Follow the instructions in the emailed
licensing to create a license file for VERICUT.

“Floating redundant” license servers- "THIS_HOST" appears in three lines of the licensing for
Floating redundant servers. Replace "THIS_HOST" in each line with one of the server computer
machine names. When done correctly, each line specifies a different server computer name.

4. Floating redundant license servers- repeat above steps on the other two license servers

"Floating redundant" servers require software and licensing be installed on three different
computers, as described under "CGTech License Servers" in the CGTech Network License
System chapter. 

“Demo” license servers skip the next 2 steps. (Go to the "Test installed software" step.)

5. Start the CGTech license server

IMPORTANT! Only one CGTech license server can be running at a time, and this MUST be the
newest version. Stop the old license server BEFORE starting the license server for the new
version or deleting the old VERICUT version software. (See how)

“Floating redundant” license servers: All three server computers must have VERICUT installed
and a “cgtech.lf” license file in the “license” directory before starting. Then, start all the servers
within 1-2 minute of elapsed time.

Click Taskbar: Start > Programs > CGTech VERICUT x.x > Start License Server (where
"x.x" is the version of the license server to start).

Automating the license server start at boot-up

While optional, this is recommended to maximize CGTech product availability. Recommended
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steps for this task vary depending in how VERICUT is run. See "Automate starting Windows
license servers" later in this chapter for setps that accomplish this task.

6. Verify the license server started

(Recommended when a license server is manually started.) The two processes listed below act
together to serve licenses. Both must start for the license server to be functional.

1. "cgtech_lmgrd"- FLEXlm license manager daemon process

2. "CGTech"- CGTech vendor daemon process

To verify the license server started correctly, click Taskbar: Start > Programs > CGTech
VERICUT x.x > View CGTech License Server Log and check for errors.

If errors occur, consult the ERRORS and Problem Solving chapter for problem descriptions and
solutions.

7. Test installed software

Run VERICUT via the icon installed on your desktop, or by clicking Taskbar: Start > Programs
> CGTech VERICUT x.x > VERICUT x.x (where "x.x" is the installed version). After the
VERICUT window opens, click the solid green “Play” arrow. A short simulation is performed.
If your licensing does not include the "Machine Simulation" option, the workpiece will be
machined but the NC machine will not move- this is normal. Close the VERICUT window (File
> Exit).

If errors occur, consult the ERRORS and Problem Solving chapter for problem descriptions and
solutions.

Congratulations! You are finished installing VERICUT on the license server computer.

What do you want to do next? (listed in recommended order of completion)

� Configure client computers to run VERICUT

� Configure an older VERICUT version for concurrent use

� Configure Unigraphics to run VERICUT

� Remove an old VERICUT version
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Configure Windows client computers

These steps apply only to VERICUT operated in a floating network environment. This section assumes
VERICUT computers can communicate with each other over the network, and that VERICUT has been
installed on the CGTech license server computer, as directed in the "Install on a Windows license server
computer" section.

Follow the procedure below to configure client computers to have access to VERICUT. Steps vary
depending on the type of network configuration, as described below.

� "Small business" network configuration-where VERICUT is installed on the local disk of a
computer acting as the CGTech license server, and a full copy of software is also installed on each
client.

� "Enterprise" network configuration-where VERICUT is installed on a network file server disk.
Clients do not have VERICUT software locally installed, but instead access the software stored on
the network file server.

 

To configure client computers in a "Small business" network configuration:

1. Install a full copy of VERICUT on each client as it was installed on the server, with the following
exceptions:

- If you are prompted for a machine Hostname, be sure to enter the Hostname of the CGTech
license server machine.

- Do not create a license or attempt to start the license server as this has already been done on the
license server computer.

2. Test VERICUT on the client.

To configure client computers in an "Enterprise" network configuration:

Note: In an "Enterprise" network configuration all systems use the same drive letter for the
"shared drive" where VERICUT files are installed.

1. Copy the VERICUT shortcut created on the CGTech license server computer, or create a shortcut
to the VERICUT command file ("vericut.bat" in the "windows\commands" directory on the
server) on each of the clients.

2. Edit the shortcut "Start in" location to not be in a CGTech-installed folder.

3. Test VERICUT on the client.

 

What do you want to do next? (listed in recommended order of completion)

� Configure an older VERICUT version for concurrent use

� Configure Unigraphics to run VERICUT

� Remove an old VERICUT version
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Things you may need to do during installation

Check Windows computers for network software

Use the appropriate procedure below to verify that network components are installed and properly
configured for use on Windows computers.

To check for network software on Windows NT:

1. Click Taskbar: Start > Settings > Control Panel.

2. Open Network and click the Protocols tab. Installed software must include “NWLink IPX/SPX
Compatible Transport” and “TCP/IP Protocol”. If components are missing, see "Troubleshooting
PC network components" in this chapter.

3. Under “The following network components are installed”, highlight “TCP/IP”.

4. If multiple TCP/IP components are installed, highlight the component bound to the ethernet card,
press Properties, then click IP Address tab. Select Specify an IP address. Ensure that a valid
network IP Address and Subnet Mask are defined. If not, enter IP Address=199.1.1.1, Subnet
Mask=255.255.255.0 When the computer is setup in a network use the actual IP Address and
Subnet Mask that define the node on the network.

5. Press OK, then on the Network window press OK.

If directed, follow prompts for loading media. If the error “The System has detected a conflict for
IP Address 199.1.1.1 ...” appears, change the IP Address, for example: 199.1.1.2

Check for network software on Windows 2000:

1. Click Taskbar: Start > Settings > Network and Dial-up Connections > Local Area
Connection.

2. Installed software must include “NWLink IPX/SPX/NetBIOS Compatible Transport Protocol” and
“Internet Protocol (TCP/IP)”. If components are missing, see "Troubleshooting PC network
components" in this chapter.

3. Under The following network components are installed, highlight “TCP/IP”.

4. If multiple TCP/IP components are installed, highlight the component bound to the ethernet card,
press Properties, then click the IP Address tab. Select Specify an IP address. Ensure that a valid
network IP Address and Subnet Mask are defined. If not, enter IP Address=199.1.1.1, Subnet
Mask=255.255.255.0 When the computer is setup in a network use the actual IP Address and
Subnet Mask that define the node on the network.

5. Press OK, then on the Network window press OK.

If directed, follow prompts for loading media. If the error “The System has detected a conflict for
IP Address 199.1.1.1 ...” appears, change the IP Address, for example: 199.1.1.2

To check for network software on Windows 95-98:

1. Click Taskbar: Start > Settings > Control Panel.

2. Open Network and click the Configuration tab. Installed software must include “IPX/SPX-
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compatible Protocol” and “TCP/IP”. If components are missing, see "Troubleshooting PC network
components" in this chapter.

3. Under The following network components are installed, highlight “TCP/IP”.

4. If multiple TCP/IP components are installed, highlight the component bound to the ethernet card,
press Properties, then click the IP Address tab. Select Specify an IP address. Ensure that a valid
network IP Address and Subnet Mask are defined. If not, enter IP Address=199.1.1.1, Subnet
Mask=255.255.255.0 When the computer is setup in a network use the actual IP Address and
Subnet Mask that define the node on the network.

5. Press OK, then on the Network window press OK.

If directed, follow prompts for loading media. If the error “The System has detected a conflict for
IP Address 199.1.1.1 ...” appears, change the IP Address, for example: 199.1.1.2
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Identify a Windows computer machine ID

Insert the CD into the license computer’s CD drive. Cancel from the install screen (if required) and double-
click on the ‘lmtools.exe’ file located in the CD’s top level directory. Your Host ID is the "Ethernet
Address" on the System Settings tab of the Lmtools window.

To identify the machine ID without using the CGTech CD, follow the steps for your license server
computer type below. Valid IDs are 12 characters and contain only the characters 0-9 and A-F.

Windows NT:

1. Log in as “Administrator”.

2. Taskbar: Start > Programs > Administrative Tools > Windows NT Diagnostics.

3. Click the Network tab, then click Transports.

Report the 12 character Transports center column entry under “Address” and associated with
“NwlnkNb”, e.g.: 00-AA-00-A8-D8-98.

If Transports does not have a “NwlnkNb” address or displays ffffffff, ffffffffffff, or 204c4f4f5020,
the required network hardware/software is missing or malfunctioning-see "Troubleshooting PC
network components" in this chapter.

Windows 2000:

1. Taskbar: Start > Programs > Administrative Tools > Computer Management.

2. Open System Tools.

3. Open System Information.

4. Click Components, then click Network.

Report the 12 character MAC Address.

If MAC Address does not have an address, or displays ffffffff, ffffffffffff, or 204c4f4f5020, the
required network hardware/software is missing or malfunctioning-see "Troubleshooting PC
network components" in this chapter.

Windows 95-98:

1. Taskbar: Start > Run.

2. In the Open: field, enter “winipcfg” (without the quotes) and click OK.

Report the 12 character Adapter Address shown, e.g. “00-AA-00-A8-D8-98”.

If errors occur using “winipcfg”, the required network hardware/software is missing or
malfunctioning-see "Troubleshooting PC network components" in this chapter.
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Troubleshooting PC network components

When required network hardware/software is missing or malfunctioning, errors typically occur when
attempting to identify the computer’s ID (ethernet address).

To correct such errors, try the following:

� Check for required network software: TCP/IP, IPX/SPX, etc.

� Check if ethernet card is installed & fully seated.

� If network software is installed, delete and re-install per the system documentation.

� When installing TCP/IP be sure to assign an IP address and bind to the network interface card via
TCP/IP protocol software.

See Windows pre-installation procedure
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Automate starting Windows license servers

While this task is optional, it is recommended to maximize CGTech product availability. If skipped, the
license server may have to be manually started after rebooting or logging off. Recommended steps for this
task vary depending on how VERICUT is run, as described below.

� Single seat configuration-where VERICUT is run only on the computer on which it was installed
=> copy the “Start Server” program to the system Startup folder.

� Floating configuration-where VERICUT is installed on a Windows NT network file server and is
run on clients in a floating environment => install an NT service.

 

To copy the “Start Server” program to the system Startup folder:

1. Click Taskbar: Start > Settings > Taskbar & Start Menu.

2. Click the Start Menu Programs tab, then click Advanced.

3. From the “All Folders/Files” list, open Programs.

4. Navigate to find and open CGTech VERICUT x.x (where “x.x” represents the version number).

5. From the “Contents” list, copy the “Start Server” program to the Startup folder (press and hold
down the <Ctrl> key while dragging), then close this window.

6. On the Taskbar Properties window press OK, then reboot.

To install a service on Windows NT:

IMPORTANT! - Only one CGTech license server can be running at a time, and this MUST be
the newest version. If a service was installed for a previous version CGTech license server, use
programs in the "windows\license" directory for that version to stop the server and remove the
existing service BEFORE installing a new service.

1. Edit the “Path” environment variable to include the “commands” directory- click Taskbar: Start >
Settings > Control Panel.

2. Open System.

3. Click the Environment tab.

4. In the System Variables list, highlight “Path”.

5. Edit the Path Value by appending: “;C:\cgtechxx\windows\commands” (without the quotes) where
“C:\cgtechxx” is where CGTech products are installed. Note that appended text begins with a
semi-colon and there are no spaces.

6. Press Set, then OK.

7. Run the CGTech “install_service” program located in the "windows\license" directory of the
version to install the service for, then reboot.

8. Verify the CGTech license server is running via the new service:
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- Click Taskbar: Start > Settings > Control Panel.

- Open Services.

The “Flexlm License Server” service status should appear “Started”. If not, repeat the steps above,
or contact CGTech Technical Support for assistance.

To install a service on Windows 2000:

IMPORTANT! - Only one CGTech license server can be running at a time, and this MUST be
the newest version. If a service was installed for a previous version CGTech license server, use
programs in the "windows\license" directory for that version to stop the server and remove the
existing service BEFORE installing a new service.

1. Edit the “Path” environment variable to include the “commands” directory- click Taskbar: Start >
Settings > Control Panel.

2. Open System.

3. Click the Environment Variables tab.

4. In the System Variables list, highlight “Path”.

5. Edit the Path Value by appending: “;C:\cgtechxx\windows\commands” (without the quotes) where
“C:\cgtechxx” is where CGTech products are installed. Note that appended text begins with a
semi-colon and there are no spaces.

6. Press Set, then OK.

7. Run the CGTech “install_service” program located in the "windows\license" directory of the
version to install the service for, then reboot.

8. Verify the CGTech license server is running via the new service:

- Click Taskbar: Start > Programs > Administrative Tools.

- Open Services.

The “Flexlm License Server” service status should appear “Started”. If not, repeat the steps above,
or contact CGTech Technical Support for assistance.
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Install on a UNIX Computer

Pre-installation procedure for UNIX computers

CGTech recommends that you install software on UNIX computers as "root", but this is not a requirement.
DO NOT "switch user" to "root" as the system may behave differently.

BEFORE YOU BEGIN - Verify that all system requirements are met. Consult the System Requirements
section and ensure that computers to run VERICUT meet or exceed requirements for devices, disk space,
memory, operating system, etc.

 

1. Mount the CD-ROM drive with “read” and “execute” access

The CD-ROM drive is already mounted on most UNIX systems. To verify that the CD-ROM is
mounted and has proper permissions for a VERICUT installation, use the UNIX “df” command
to identify mounted file systems. Check for availability of “/cdrom” or “/CDROM”, and ensure
it has read and execute access. (See UNIX mount commands)

Reseller Demo licenses skip the remaining steps in this section. Go to "Install on a UNIX license server
computer".

2. HP server computers- enable access to network file “/dev/lan0”

When this network device driver file does not have read/write access for normal users, errors
result when anyone except “root” runs VERICUT. Change access permissions on this file, for
example type: chmod 666 /dev/lan0

3. Identify the machine ID for licensing

Change directories to the CD-ROM mount directory (e.g. cd /cdrom), then type:
“./LMHOSTID.UX” (without the quotes). If this command fails, try: “./lmhostid.ux” or
“./LMHOSTID.UX\;1”. Valid IDs are 8 or 12 characters and contain only the characters 0-9 and
A-F.

To identify the machine ID without using the CGTech CD, see "Identify a UNIX computer
machine ID" later in this chapter.

- If you already have licensing for this version— Verify that the machine ID shown in your
licensing matches that of the computer to be the CGTech license server. If they are different
contact the CGTech Licensing Department for assistance.

- If you DO NOT have licensing for this version— Complete and return the License Request Form
in the CD booklet, or submit the application at www.cgtech.com/license.

Ignore the next step if you are running VERICUT only on the computer on which you are installing.

4. Verify clients can communicate with the CGTech license server

If you are installing VERICUT in a floating network with multiple clients, all VERICUT
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computers must be able to communicate with each other over the network. Each computer must
have a hostname assigned and appropriate entry in a network file, for example: “ /etc/hosts”.

Typically VERICUT is installed using the license server computer on a network accessible disk or
file system. The installation program assumes the installing computer is the license server, but
this can be changed during installation.

Choose an install destination directory and path that can be used on the CGTech license server and
all client computers. All UNIX computers must “see” the same path to VERICUT.

Continue with "Install on a UNIX license server computer".
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Install VERICUT on a UNIX CGTech license server computer

Follow the procedure below to install VERICUT on the computer to be the CGTech license server (as
identified in the CGTech-supplied licensing).

 

1. Complete the pre-installation procedure for UNIX computers

2. Insert the CD, change to the CD-ROM directory, and run the installation program

Change directories to the CD-ROM mount directory (e.g. cd /cdrom), then type: “./INSTALL.UX”
(without the quotes). If this command fails, try: “./install.ux” or “./INSTALL.UX\;1”. The
installation program will guide you through the install process. If the installation program will
not run, see "Mount UNIX CD-ROM drives with proper access".

- If you are prompted for a machine Hostname, be sure to enter the Hostname of the CGTech
license server machine.

3. Create a license file from the emailed licensing received from CGTech

Use the correct licensing for this version of software-see the Introduction for details and
instructions on how to obtain licensing from CGTech. Follow the instructions in the emailed
licensing to create a license file for VERICUT.

“Floating redundant” license servers- "THIS_HOST" appears in three lines of the licensing for
a Floating redundant server. Replace "THIS_HOST" in each line with one of the server
computer machine names. When done correctly, each line specifies a different server computer
name.

4. Floating redundant license servers- repeat above steps on the other two license servers

"Floating redundant" servers require software and licensing be installed on three different
computers, as described under "CGTech License Servers" in the CGTech Network License
System chapter. 

“Demo” license servers skip the next 2 steps. (Go to the "Test installed software" step.)

5. Start the CGTech license server

IMPORTANT! Only one CGTech license server can be running at a time, and this MUST be the
newest version. Stop the old license server BEFORE starting the license server for the new
version or deleting the old VERICUT version software. (See how)

“Floating redundant” license servers: All three server computers must have VERICUT installed
and a “cgtech.lf” license file in the “license” directory before starting. Then, start all the servers
within 1-2 minute of elapsed time.

Start the license server via the “start_server” command file located in the "computertype/license"
directory of your VERICUT software installation, where "computertype" is one of the
following: hp, rs, sgi, solaris (refers to the license server computer type).
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Automating the license server start at boot-up

While optional, this is recommended to maximize CGTech product availability. Exact steps for
this task vary, depending on the server computer type. See "Automate starting UNIX license
servers" later in this chapter for setps that accomplish this task.

6. Verify the license server started

(Recommended when a license server is manually started.) The two processes listed below act
together to serve licenses. Both must start for the license server to be functional.

1. "cgtech_lmgrd"- FLEXlm license manager daemon process

2. "CGTech"- CGTech vendor daemon process

To verify the license server started correctly, view the “cgtechd.log” file stored in the
"computertype/license" directory and check for errors.

If errors occur, consult the ERRORS and Problem Solving chapter for problem descriptions and
solutions.

7. Test installed software

Run VERICUT via the “vericut” command file stored in the "computertype/commands" directory
of your VERICUT software installation, where "computertype" is one of the following: hp, rs,
sgi, solaris.

After the VERICUT window opens, click the solid green “Play” arrow. A short simulation is
performed. If your licensing does not include the "Machine Simulation" option, the workpiece
will be machined but the NC machine will not move- this is normal. Close the VERICUT
window (File > Exit).

If errors occur, consult the ERRORS and Problem Solving chapter for problem descriptions and
solutions.

Congratulations! You are finished installing VERICUT on the license server computer.

What do you want to do next? (listed in recommended order of completion)

� Configure client computers to run VERICUT

� Configure an older VERICUT version for concurrent use

� Configure Unigraphics to run VERICUT

� Remove an old VERICUT version
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Configure UNIX client computers

These steps apply only to VERICUT operated in a floating network environment. This section assumes
VERICUT computers can communicate with each other over the network, and that VERICUT has been
installed on the CGTech license server computer, as directed in the "Install on a UNIX license server
computer" section.

To configure UNIX client computers:

1. "Floating Redundant" servers- choose one of the three license servers to be the “primary
server” from which clients will access VERICUT.

2. On each client- make a directory path identical to the install destination used on the CGTech
license server. VERICUT must "see" the same path on all computers.

3. Mount the client install destination directory to the same directory on the license server.

For example, to mount a client to a server named “sun23” with VERICUT installed in
“/usr/cgtechxx” you could use the command: “mount sun23:/usr/cgtechxx /usr/cgtechxx”.

4. Export the mount and make an entry in the license server’s boot-up file to accept the mount from
the client. Consult your operating system documentation if you need more information.

5. Finally, copy the “vericut” command file from the server “computertype/commands” directory
(where "computertype" is the appropriate for the client) to the client “/usr/bin” directory.
Executing this file will provide the client with access to VERICUT stored on the license server
computer.

6. Test VERICUT on the client.

Schematic of mounting UNIX clients to VERICUT floating license servers:
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What do you want to do next? (listed in recommended order of completion)

� Configure an older VERICUT version for concurrent use

� Configure Unigraphics to run VERICUT

� Remove an old VERICUT version
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Things you may need to do during installation

Mount UNIX CD-ROM drives with proper access for installing
VERICUT

The CD-ROM drive must be mounted with “read” and “execute” access to run the VERICUT installation
program. Some systems, such as SGI, may not have the proper access and must be re-mounted.

To see if your CD-ROM drive is mounted with proper access:

1. Use the “df” command to list mounted file systems. If mounted, the device name will appear under
the “Filesystem” heading (beginning with “/dev”) and the mount directory will appear under the
“Mounted on” heading (e.g. “/cdrom” or “/CDROM”).

2. Check to see if the /cdrom (or /CDROM) directory has “read” AND “execute” access.

If /cdrom has “read” and “execute”— Continue with the pre-installation procedure.

If /cdrom does NOT have “read” and “execute”— Note the current mounted device name and
continue with the next step in this procedure below.

3. Unmount the incorrectly mounted device using the “umount /CDROM” command.

To mount UNIX CD-ROM drives with “read” and “execute” access:

In the example mount commands below “/cdrom” represents the mount directory for the CD-ROM
drive. Substitute “#” with the SCSI ID of your CD-ROM drive. After mounting, verify the
device is mounted via the “df” command, as described above.

Tips:

- Avoid typing errors by cutting and pasting device names.

- If the “mount” command is not in your path, try “/etc/mount”.

Computer type: UNIX mount command:

HP
mount /dev/dsk/c201d#s0 /cdrom

IBM
mount -vcdrfs -r /dev/cd0 /cdrom
(or use SMIT)

SGI
mount -t iso9660 -o setx
/dev/scsi/sc0d#l0 /CDROM

(2nd to last character in "sc0d#l0" is small “L”, not
number “1”) If this doesn't work, try:
mount -t iso9660 -o setx
/dev/rdsk/dks0d#vol /CDROM

Solaris Volume Mgr. typically auto-mounts, or try:
mount -r -F hsfs /dev/dsk/c0t#d0s2
/cdrom
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Identify a UNIX computer machine ID

Insert the CD into the license computer’s CD drive. Run the "LMHOSTID.UX" (or “lmhostid.ux” or
“LMHOSTID.UX\;1”) utility program on the CGTech CD.

To identify the machine ID without using the CGTech CD, follow the steps for your license server
computer type below. Valid IDs are 8 or 12 characters and contain only the characters 0-9 and A-F.

HP:

1. In an operating system window, type: “/etc/lanscan” (without the quotes).

2. Report the 12 character “Station Address” associate with the “lan0” Net-InterFace (begins with
“08000” or “0060”), for example: “08000935CDEF”.

IBM:

1. In an operating system window, type: “uname -m” (without the quotes).

A 12 character ID is displayed, e.g. “000035913000”. If the uname command displays
00FFFFFF4C00 or 000027774C00, the required network hardware/software is malfunctioning.
Contact IBM for assistance.

2. Delete two leading and two trailing zeros and report the eight remaining characters, for example:
“00359130”.

SGI:

1. In an operating system window, type: “/etc/sysinfo” (without the quotes).

2. Report the first four pairs of digits (8 characters total) in the system ID. In the example below,
“69088aec” would be reported.

 System ID:
 69 08 8a ec 00 00 00 00 00 00 00 00 00 00 00 00
 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00

Solaris:

1. In an operating system window, type: “hostid” (without the quotes).

2. Report the 8 character HostID shown, for example: “52000e12”.
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Automate starting UNIX license servers

While this task is optional, it is recommended to maximize CGTech product availability. If skipped, the
license server may have to be manually started by "root" after rebooting or logging off.

To configure a UNIX license server to auto-start at boot-up:

IMPORTANT! - Only one CGTech license server can be running at a time, and this MUST be
the newest version. If a boot-up file was edited for a previous version CGTech license server, be
sure to update the same file in a similar manner to auto-start the new license server instead.

1. Logged in as "root", edit one of the computer’s boot-up files (typically in the “/etc” directory and
start with the letters “rc”) to include the full path to the CGTech “start_server” program. Examples
follow.

“Floating Redundant” servers: Be sure to configure all three license server computers to auto-
start.

2. Reboot the server computer(s) and verify the license server started correctly.

If a license server fails, try adding “sleep 1” after the start_server entry in the boot-up file, then
reboot again.

 

Computer specific examples:

Note that exact steps, filenames, and entries included in system boot-up files can vary, depending on the
installation.

HP:

1. Logged in as “root”, change to the “/sbin/rc3.d” directory.

2. Create the link => ln -s /sbin/init.d/rc.vericut.start S903rc.vericut.start

3. Copy and rename the CGTech “start_server” command script from the “hp/license” directory to
“/sbin/init.d/rc.vericut.start”. The file should be owned by “root”, the group should be “sys”, and
permissions r-xr--r--. For example:

cp /usr/cgtech4x/hp700/license/start_server /sbin/init.d/rc.vericut.start

chmod 544 rc.vericut.start

chown root:sys rc.vericut.start

4. Shutdown and reboot the computer (e.g. /etc/shutdown -r now).

IBM:

Edit the “/etc/inittab” file to have an entry similar to:

lmgrd:2:once:sh /usr/cgtech4x/rs/license/start_server

SGI:
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1. Change to the “/etc/init.d” directory.

2. Copy the “lp” file to a file named “cgtech_lmgrd”. For example:

cd /etc/init.d

cp -p lp cgtech_lmgrd

3. Edit the “cgtech_lmgrd” file to have the following entries:

#! /sbin/sh

#Tag 0x00000f00

# Start the CGTech license server

case “$1” in

  ’start’)

  /usr/cgtech4x/sgi/license/start_server ## example

  ;;

  ’stop’)

  ;;

  *)

  echo “usage: $0 {start|stop}”

  ;;

esac

4. Last, change to the “/etc/rc2.d” directory and create a link as follows:

cd /etc/rc2.d

ln -s /etc/init.d/cgtech_lmgrd S99cgtech_lmgrd
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Configure older VERICUT versions for concurrent use

When VERICUT was previously installed, CGTech recommends that the older VERICUT version not be
removed until you are comfortable with the new version. This version can run concurrently with VERICUT
versions as old as 4.0. Even older versions may work, but some features/options may not be available in the
older version of VERICUT.

To configure 4.x VERICUT versions for concurrent use with this version:

1. If the older VERICUT version used an license server auto-start mechanism, update it to point to
the new license server. (Ref. "Automate starting Windows license servers" or "Automate starting
UNIX license servers", whichever applies).

The following must be done on each computer that will use the older VERICUT version:

2. Rename the old version license file (e.g. “cgtech.old”) and copy the new license file to the 4.x
"license" directory. (DO NOT delete the old license file!)

3. Reseller Demo licenses skip this step. Using a text editor (such as Windows Notepad or UNIX vi)
Copy the “SERVER” line from the old license file and replace this line in the new license file.
Save the edited file as plain text. No formatting characters, line feeds, etc. are permitted as they
will corrupt the file.

4. Test the older version of VERICUT.

5. (Optional) Re-test the installed 5.x VERICUT version to make sure it still functions as expected.

 

What do you want to do next?

� Configure Unigraphics to run VERICUT

� Remove an old VERICUT version
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Configure Unigraphics to run VERICUT

These steps apply only when VERICUT will be run directly from UG. If VERICUT will only be run
outside of UG, then ignore the steps in this section.

To configure UG to run VERICUT two environment variables must be defined in the UG environment. For
proper formats, refer to other environment variables set for UG, or consult your operating system
documentation.

� UGII_VERICUT— Must point to the “ug10tovc3” command file in the "computertype/license"
directory of your VERICUT software installation, where "computertype" represents the computer
on which UG/VERICUT is operated.

� UGII_ENV— Must be assigned a numeric value of “2”.

 

Continue with removing an old VERICUT version
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Remove an old VERICUT version

Uninstalling is recommended when a VERICUT version in not needed, or when disk space is limited. Use
the appropriate procedure below to remove a version of VERICUT from your computer.

To remove VERICUT from a UNIX computer:

1. Stop the CGTech license server, if running: execute the CGTech “stop_server” program for the
version being uninstalled. Do this BEFORE uninstalling!

2. Change to the directory above where VERICUT was installed. For example, if installed in
“/usr/cgtech44”, then type: cd /usr

3. Remove (delete) the entire tree of directories and files beginning with the CGTech installation
directory, for example: “rm -r cgtech44”

To remove VERICUT from a Windows computer:

1. Stop the CGTech license server, if running- click Taskbar: Start > Programs > CGTech
VERICUT x.x > Stop Server (where "x.x" is the version of the license server to stop). Do this
BEFORE uninstalling!

2. Remove the auto-start mechanism for the license server, if configured:

- If the “Start Server” program was copied to the system Startup folder- remove it.

- If an NT Service was installed- remove it via running the “Remove Service” program for the
version being uninstalled (located in the "license" directory).

Note: Skip the next step if removing 5.0 or later version of VERICUT, or if removing a 4.x version and
Exceed is used by other applications, such as UG or another version of VERICUT.

1. Remove the CGTech-installed version of Exceed:

- Click Taskbar: Start > Programs > Exceed > Uninstall.

- Open Add/Remove Programs and click the Install/Uninstall tab.

- In the list of installed programs, highlight the Exceed software version to remove.

- Click Add/Remove, then Yes.

2. Delete CGTech programs.

- On the Add/Remove Programs window Install/Uninstall tab.

- In the list of installed programs, highlight the CGTech software version to remove.

- Click Add/Remove, then Yes.

There may be program folder/files that are not removed by uninstalling. These were created after
VERICUT was installed and will have to be removed manually.

 

What do you want to do next?
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� See how to install this version of VERICUT on: Windows, UNIX
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Stopping a CGTech license server

Only one CGTech license server can be running at a time, and this MUST be the newest version. Use the
procedures below to stop an existing CGTech license server, such as required before starting the license
server for the new version or deleting VERICUT software.

To stop a CGTech license server:

� Windows license servers— Click Taskbar: Start > Programs > CGTech VERICUT x.x > Stop
License Server (where "x.x" is the version of the license server to stop). On NT, CGTech
recommends you perform this task as "Administrator".

�  UNIX license servers— As "root" , stop the active license server via the “stop_server” command
file located in the "computertype/license" directory of your VERICUT software installation, where
"computertype" is one of the following: hp, rs, sgi, solaris.

If errors occur, consult the ERRORS and Problem Solving chapter for problem descriptions and potential
solutions.
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Chapter 4  CGTech Network License System
(CNLS)

About the CGTech Network License System

The CGTech Network License System, or “CNLS”, controls the use of CGTech software products via a
“license server” program that runs in the background. When started, the license server reads an encoded
license file (see below) containing information about the customer site, the CGTech products licensed for
use, and the computer environment. CNLS operates in stand-alone or "floating" network environments.
TCP/IP network software must be installed and running in order for CNLS to operate. For TCP/IP to
operate, an ethernet card or equivalent network interface card is required.

When a CGTech product is used, a license is requested from the license server. If the license is available,
the license server checks out the license to the requesting user. If the license is not available either because
all available licenses have been checked out or the product license was not purchased, then a message
similar to “license not available” is issued. When the product is exited, its corresponding license is checked
into the license server.

What do you want to do?

� Learn about the CGTech License file

� Learn about CGTech license server types

� See how to transfer a license to another computer
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The License file

The licensing for CGTech products and their features is provided via a License file which is a database of
user environment/purchase information. This file is typically named “cgtech.lf” and stored in the “license”
directory under the CGTech installed directory structure. The License file is created and supplied with
accompanying instruction by CGTech via Email. No further editing is required.

When VERICUT is started for the first time, or started after a server shutdown, CNLS references the
License file to see what and how many CGTech products are available at your company. When additional
software or licenses are purchased, there is typically no need for subsequent software installation. All that
is required is to stop the CGTech license server, rename the old license and put the new license in place,
then restart the CGTech license server.

If you encounter problems starting VERICUT with your License file, consult the ERRORS and Problem
Solving chapter for possible problems and recommended solutions.
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CGTech license servers

A CGTech license server controls access to CGTech products. If the license server becomes inoperable,
then CGTech products can not be run. If VERICUT is running when the license server fails, processing
halts and a message appears similar to “license not available”. At this point there are two options: 1-exit
VERICUT, 2-restart the license server and resume VERICUT operation.

Various license server configurations can be licensed, depending on your specific needs. When you request
licensing from CGTech, be sure to indicate the desired server configuration and computer types on which
VERICUT will be operated.

CGTech license server configurations:

� Floating license server

� Floating redundant license server

� Demo license server

 

Floating license server

A “floating” license server is the default configuration, and allows CGTech products to be run on computer
types having similar operating systems in a network environment. CGTech products may be run on the
server or client computers. Licensing for single or multiple computer types can be specified at the time
licensing is requested from CGTech.

Floating license server examples:
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Floating license time zone restrictions

The CNLS license server machine and client machines must be within the same time zone. If a client
machine's clock differs from the server clock by more than 30 minutes when requesting a license, the
license is not granted. WARNING: Confusion may occur during the traditional fall and spring daylight
savings time adjustments.

Floating redundant license server

A “floating redundant” license server is similar to a Floating license server, except uses three server
computers that communicate with each other to act as a single “logical server”. This configuration is
available at no extra cost. Server redundancy is specified at the time licensing is requested from CGTech by
providing three computer host IDs.

Recovering from a floating redundant license server failure

If one of the three server computers fails or stops communicating for some reason, there should be no effect
as long as the other 2 are running, UNLESS it happens to be the computer from which the client computers
are getting the executables (known as the “primary server”). In that case, change the client computer
mounts from the computer that failed to one of the servers still running. The name of the mount directory
should NOT be changed, just what it is mounted to. Once that is done, the client computers should be able
to operate CGTech products again. If two of the three server computers fail, then CGTech products can not
be operated.

Floating redundant license server example with 1 computer type:

Floating redundant license server example with multiple computer types:
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Demo license server

A “demo” license server uses a special unlocked license that allows CGTech products to be run on
specified computer types without regard to the computer’s Host ID. Demo licensing is strictly controlled by
CGTech. Depending on the demo license configuration, demo servers can limit the products and quantity of
licenses that can be used, or may allow unlimited access.

License checkout methods

CNLS determines whether a particular license is available when requested by a user. There are two
methods available for checking out licenses, as described by the sections that follow. Regardless of the
checkout method used, licenses that are successfully checked out remain in the user’s possession until the
program is exited.

� Reservation checkout— This is the default checkout method and checks out one (1) of each
license available when a CGTech product is executed. For example, when VERICUT is executed,
it requests a “Verification” license and a license for each optional module available for use with
VERICUT.

� Dynamic checkout— This is checkout method checks out licenses on an “as needed” basis. Using
the example above, only the “Verification” license is checked out upon execution. The first time
the user attempts to use a licensed feature, the program requests the corresponding license. For
example, the first time a multi-axis motion is attempted, a “Multi-Axis” license is requested, and
so on.



Help on Installing VERICUT

40

The dynamic checkout method is specified by including the word “dynamic” anywhere on the
command line when executing VERICUT, for example: “vericut dynamic”.
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Transferring a license to another computer

When the user site has a valid software maintenance agreement with CGTech, licensing for CGTech
software products can be transferred from the original license server computer(s) to a different computer. A
license transfer is requested via submitting a VERICUT License Request Form. This form is available in the
CD booklet, or you can submit requests for licensing via the CGTech Web Site.
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Chapter 5  ERRORS and Problem Solving

Error messages - listed alphabetically

This section describes error messages and problems which may occur while installing VERICUT. Note that
installation troubleshooting on Windows NT operating systems require “Administrator” privileges, UNIX
computers typically require “root” privileges. Also, ensure that you are logged in on the computer for
which CGTech products have been licensed, known as the “server” computer.

Where to look for error messages

Check for error messages in the following locations when experiencing difficulty running CGTech products
or the license server:

� CGTech Daemon log file— Named “cgtechd.log” and located in the “license” directory, this file
stores informational messages about license daemon activity. Activity recorded by this file
includes checking out and returning licenses to the license server, as well as starting and stopping
the license server daemons.

� Computer screen/DOS window— Computer screen error messages are displayed when problems
are encountered during the execution of VERICUT or the start_server command.

� VERICUT Log file— Typically named “vericut.log” and stored in the directory from which
VERICUT has been executed, this file stores informational messages about the verification
session.

Note: Errors that occur while runing VERICUT are described in the "ERRORS / Problem Solving" section
in the VERICUT user documentation.

Error messages, problems and solutions

Common installation-related error messages are listed below in alphabetical order (case and special
characters not considered), along with problem descriptions and recommended solutions.

Access denied File creation error

Problem: license server start attempted when a CGTech license server is already running. Only
one (1) CGTech license server may be running at a time.

Solution: Windows use the CGTech “Stop Server” program to stop the active license server
process, UNIX use the “stop_server” program in the “license” directory. Then try to start the
license server again.

access violation (0x0000005), Address: 0x77f32d5e

See "Unable to access USER directory".

Address already in use
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See "socket bind: Address already in use".

address in use: port 1700 (“1701”, etc.)

See "socket bind: Address already in use".

An application error has occurred and an application error log is being generated

See "Dr. Watson for Windows NT An application error has occurred".

A required .DLL file ... was not found

See "Out of environment space".

Attempt to access private resource denied

See "Could not allocate color cells in the color map".

BadAccess (attempt to access private resource denied)

See "X Error of failed request: BadAccess (attempt to access private resource denied)"

bad code for ...

Error appears for ALL licensed features:

Problem: company name (or ID in V3.4 or later licensing) in license file is incorrect.

Solution: access the CGTech License Manager or edit the "cgtech.lf" license file to re-enter the
Company Name (or ID) as shown on the license information, then create and test a new license
file. If necessary, start the license server.

Error appears for only 1 or some of the licensed features:

Problem: password data in the license file is incorrect.

Solution: access the CGTech License Manager or edit the "cgtech.lf" license file to re-enter the
password data as shown on the license information; valid characters are alphabet characters A-F
and numbers 0-9. Then create and test a new license file. If necessary, start the license server.

Bad name ...

See "X error failed request: Bad name".

BadAccess (attempt to access private resource denied)

See "X Error of failed request: BadAccess (attempt to access private resource denied)".

Cannot connect to license server ... Connection refused

See "Cannot connect to license server (-15,12:61) Connection refused".

Cannot connect to license server ... Connection refused (-15)
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Problem: CGTech product executed when the license server is not running.

Solution: start the license server before attempting to operate VERICUT. It is recommended to
automate the license server start, as described under Automate starting a Windows CGTech
license server 8. or Automate starting a UNIX CGTech license server 6., whichever applies.

Problem: hostname is not assigned to the license server computer. Check the appropriate network
file for a valid hostname assignment and IP address:

UNIX- /etc/hosts

Windows 95/98- C:\windows\hosts

Windows NT 3.51- C:\winnt35\system32\drivers\etc\hosts

Windows NT 4.0- C:\winnt\system32\drivers\etc\hosts

Solution: consult the operating system documentation about actions that assign a valid hostname
and IP address prior to attempting to start the license server. Use the “ping” command to verify
that the computers can communicate over the network.

Problem: multiple hostnames are assigned to the license server computer. Check the appropriate
network file for multiple hostname assignments (see above).

Solution: delete redundant hostname assignments to leave one valid hostname, then re-start the
license server.

See also other messages output with this message.

Cannot connect to license server ... Connection refused (-15,8)

Problem: an IP address is not available for use. This problem typically occurs on Windows 95/98
computers with multiple TCP/IP network components installed, but they may not be installed
correctly.

Solution: assign the same IP address to all network components, Then try to start the license
server again.

Cannot connect to license server (-15,12:61) Connection refused

Problem: server stop attempted when the CGTech license server is not running.

Solution: do not attempt to stop a CGTech license server that is not running.

Cannot connect to license server (-15,12:146) Connection refused (-15)

Problem: server auto-start attempted by normal user when “cgtechd.log” file permissions prevent
overwritting this file.

Solution: owner of “cgtechd.log” file must start the CGTech license server, or change permissions
to permit overwritting this file.

See also "Cannot connect to license server ... Connection refused (-15)".

Cannot connect to license server ... WinSock error code (-15)

Same as "Cannot connect to license server ... Connection refused (-15)".
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Cannot connect to license server [-15,11:10060] ... WinSock error code

Problem: the “cgtech.lf” license file specifies incorrect full path to the “CGTech” license server
daemon (second line of the file). This problem typically occurs when an old “cgtech.lf” license
file has been copied to a new “license” directory

Solution: edit the second line of the license file to specify the correct path to the “CGTech”
license server daemon, then try to start the license server again.

Cannot connect to X server!

If preceded by “Cannot open connect stream”- see "Cannot open connect stream".

If preceded by “Unable to access USER directory”- see "Unable to access USER directory".

Problem: X server is not running when attempting to operate VERICUT or start a license server.

Solution: consult the computer operating system documentation for commands that start the X
server (e.g. “X11start”).

Problem: hostname is not assigned to the CGTech license server computer. Checking the
appropriate network file for a valid hostname assignment:

UNIX- /etc/hosts

Windows 95/98- C:\windows\hosts

Windows NT 3.51- C:\winnt35\system32\drivers\etc\hosts

Windows NT 4.0- C:\winnt\system32\drivers\etc\hosts

Solution: consult the computer networking documentation about the steps required to assign a
valid hostname prior to starting the CGTech license server.

Problem: the license server computer is remotely logged in via an X-window when VERICUT is
executed, however, the display has not been configured to open on the X-window terminal.

Solution: ensure that the license server computer is sending the window display to the X-terminal,
e.g. on the license server computer type a command similar to: “/usr/bin/X11/xterm -display
xtermcomputername:0.0 &” where “xtermcomputername” is the X-terminal machine name.
Ensure that the X-window terminal computer has been configured to allow windows from other
computers to be opened, e.g. on the X-terminal type a command similar to: “/usr/bin/X11/xhost
+”.

Problem: installation or license server start attempted on RS6000 computer by someone who has
switched user to “root” via the UNIX “su” command.

Solution: log out, then log back in as “root”. Then start the installation or license server again

Cannot create temporary file while processing command line user arguments

See "cannot create temporary file while processing command line user arguments".

cannot create temporary file while processing command line user arguments

Problem: VERICUT was executed with command line options from a directory where the user
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does not have write access to the root directory of that disk (e.g. Windows- “C:\”, UNIX- “/”).
This problem typically occurs when VERICUT attempts to write temporary files. Check for
write permissions to the location where temporary files are to be stored- ref. "VERICUT System
Requirements".

Solution: change permissions on the root directory to allow write access, otherwise define the
TEMP environment variable (Windows) or the TEMPDIR environment variable (UNIX) to
point to a directory where the user has write access.

Cannot create ...

Problem: file can not be created by the current user.

Solution: file owner must delete file or change access permissions to allow user access.

cannot execute

Problem: the executed file does not have “executable” access.

Solution: change permissions on all CGTech script files and executables to have executable
access (e.g. UNIX type: chmod 755 filename).

As installed, all CGTech installed script files and executables have executable access, unless
modified by the installer. If other “executable access” related problems occur delete the current
software installation, then re-install VERICUT as directed by the Installation chapter.

Cannot find License file (-1,73:2) No such file or directory

Problem: a CGTECH_LF environment variable is defined pointing to an obsolete (wrong version)
“cgtech.lf” license file.

Solution: CGTech command files automatically establish this environment variable. Unset the
currently defined CGTECH_LF environment variable, then re-execute the CGTech product.

Problem: the “cgtech.lf” license file does not exist in the “license” directory, or does not exist in
the location specified by the CGTECH_LF environment variable.

Solution: if the license file does not exist- follow emailed instructions or access the CGTech
License Manager to create and test a license file. If necessary, start the license server.

If the license file does exist- edit the CGTECH_LF environment variable declarations in each of
the CGTech command scripts stored in the “commands” directory to specify the true location of
the license file. If the CGTECH_LF environment variable declarations are correct as is, ensure
that the CGTECH_LF environment variable has not been previously set before the CGTech
command script is executed.

Cannot find SERVER hostname in network database (-14,7)

Problem: hostname or ID in the license file is incorrect.

Solution: determine the true hostID, as described under "Identify a Windows computer machine
ID" or "Identify a UNIX computer machine ID" in the Installation chapter. Also ensure that a
valid hostname is detected by the CGTech License Manager when creating the license file.

If the license information is correct but the data has been entered incorrectly, use the CGTech
License Manager to correct the Hostname or ID. Create and test a new license file. Then try to
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start the license server again

If the license information is incorrect for the desired licensed computer, complete and submit a
VERICUT License Request Form which identifies the desired license server computer.

Problem: hostname is not assigned to the license server computer. Check the appropriate network
file for valid host name-IP address assignment:

UNIX- /etc/hosts

Windows 95/98- C:\windows\hosts

Windows NT 3.51- C:\winnt35\system32\drivers\etc\hosts

Windows NT 4.0- C:\winnt\system32\drivers\etc\hosts

Solution: edit the server (and clients) network file to specify all computers to be communicated
with, especially the license server computer. Consult the computer networking documentation
for details about assigning a valid hostname prior to attempting to operate VERICUT or the
license server.

Cannot find SERVER hostname in network database (-14,7:11004) WinSock error code

Problem: TCP/IP is installed, but does not have a valid IP address bound to the network interface
card.

Solution: assign IP address and bind to network interface card via TCP/IP protocol software
(consult the operating system documentation). Use the “ping” command to verify that the
computers can communicate over the network. Then try to start the license server again.

Problem: hostID in license file is incorrect.

Solution: determine the true hostID, as described under "Identify a Windows computer machine
ID" or "Identify a UNIX computer machine ID" in the Installation chapter. Also ensure that a
valid hostname is detected by the CGTech License Manager when creating the license file.

If the license information is correct but the data has been entered incorrectly, use the CGTech
License Manager to correct the HostID. Create and test a new license file. Then try to start the
license server again

If the license information is incorrect for the desired licensed computer, complete and submit a
VERICUT License Request Form which identifies the desired license server computer.

See also "Cannot find SERVER hostname in network database (-14,7:11004) WinSock error code
(-14)"

Cannot find SERVER hostname in network database (-14,7:11004) WinSock error code (-14)

Problem: hostname is not assigned to the CGTech license server computer. Check the appropriate
network file for valid host name-IP address assignment:

UNIX- /etc/hosts

Windows 95/98- C:\windows\hosts

Windows NT 3.51- C:\winnt35\system32\drivers\etc\hosts

Windows NT 4.0- C:\winnt\system32\drivers\etc\hosts
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Solution: edit the license server (and clients) network file to specify all computers to be
communicated with, especially the CGTech license server computer. Consult the computer
networking documentation for details about assigning a valid host name prior to attempting to
run a CGTech product or license server.

Problem: TCP/IP is installed, but does not have a valid IP address bound to the network interface
card.

Solution: assign IP address and bind to network interface card via TCP/IP protocol software, then
start the license server. If unsuccessful, remove and re-install the network software components,
then retry.

Problem: hostname in the license file is incorrect.

Solution: ensure that a valid hostname is detected by the CGTech License Manager when creating
the license file.

If the Hostname has been edited- access the CGTech License Manager window to re-read the
Hostname, then try to start the license server again.

If the license information is incorrect for the desired licensed computer, complete and submit a
VERICUT License Request Form which identifies the desired license server computer.

cannot open C:\exceed\user\exceed.cfg

Problem: the “exceed.cfg” and related .DLL files have been corrupted while backing up the
Windows NT system.

Contact CGTech Technical Support for assistance.

Cannot open connect stream

Problem: VERICUT V3.0 executed on Windows NT when the “HomeDir” string value in the
Registry is incorrect.

Solution: edit the “HomeDir” string value to point to where Exceed software has been installed by
CGTech, for example “C:\usr\cgtech\exceed” where “C:\usr\cgtech” is where VERICUT has
been installed. Refer to the steps listed under "Unable to access USER directory".

cannot open default font

See "Can’t open default font".

Cannot open file ... .hlp

Problem: Help file has been requested that has not been installed, or the Help file can not be
located on the CD.

Solution: pre-V3.3 systems must install the Help file before they can be accessed. V3.3 or later
systems can choose not to install the Help files, then access the Help files store on the CD.
Ensure the CD is inserted in the CD-ROM drive and the drive is properly mounted prior to
attempting to access the Help file on the CD.

Also ensure that the HLPPATH environment variable is properly set. This variable is set
differently depending in how the CGTech software was accessed:
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CGTech software accessed via the CGTechsw icon in the “CGTech VERICUT” folder:

- Start>Run: regedit

- Choose: HKEY_LOCAL_MACHINE, Software, CGTech, VERICUT, Version 3.x,
Environment, HLPPATH: “%CGTECH_HELP%\hhelp;D:” where “D:” represents the CD-
ROM drive.

CGTech software accessed via a CGTech batch file:

- The batch file (e.g. cgtechsw.bat, or vericut.bat) must contain an HLPPATH entry, e.g.: “set
HLPPATH=%CGTECH_HELP%\hhelp;D:” where “D:” represents the CD-ROM drive.

cannot open lock file (C:\flexlm\CGTech): No such file or directory

See "Can’t make directory C:\flexlm, errno: 2(No such file or directory)".

Cannot perform malloc

See "X Toolkit Error: Cannot perform malloc".

Cannot read data from license server (-16,15) (-16)

Problem: an automatic license server start has failed during bootup of an HP computer.

Solution: add the entry “sleep 5” at the end of the “start_server” file to allow time for the server
process to start without conflicting with other processes that may be attempting to start during
bootup.

cannot support depth 12

Problem: the current color setting is not supported by the Exceed X window software.

Solution: change the display to use a supported color setting: 256 colors (optimum performance)
or true color.

Cannot write to ...

Problem: if seen when using on-line Help, HyperHelp is attempting to save a printer
configuration file (“.Xpdefaults”) via the $HOME environment variable. The $HOME
environment variable is not defined, or points to a directory which does not have “write” access.

Solution: if the $HOME environment variable is not defined- define $HOME in the CGTech
product startup script to specify a directory where HyperHelp data is to be saved and read from.

If the $HOME environment variable is defined- ensure that the directory specified by $HOME can
be written to.

Can't get server list: No SERVER lines in License file (-13,66)

See "No SERVER lines in License file".

Can’t make directory C:\flexlm, errno: 2(No such file or directory)

Problem: Windows computer is not configured with a “C:” drive when a “C:” drive is required by
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Exceed software.

Solution: create a “C:” drive partition or map a network drive called “C:” which uses an existing
drive.

Can’t open c:\flexlm\lmgrdl.362, errno: 2

See "Can’t make directory C:\flexlm, errno: 2(No such file or directory)".

Can’t open default font

Problem: Windows NT is not configured to use the fonts required by Exceed software.

Solution: ensure “Show only True Type fonts...” is not selected, for example on NT 4.0:

- Taskbar: Start>Settings>Control Panel

- Open “Fonts”

- View menu>Folder Options...

- True Type Fonts tab, unselect “Show only True Type fonts in the programs on my computer”,
OK

Can’t read bookmarks and annotations - $HOME and $HHLOCAL not set.

Problem: the $HOME environment variable is not defined.

Solution: define $HOME in the CGTech product startup script to specify a directory where Help
changes can be saved and retrieved.

Can’t read printer setup information. Check $HHHOME and $XPPATH. Does ... exist!

Problem: this error occurs when attempting to access Help documentation and the “FontMetrics”
directory does not exist, or has been renamed to the DOS short (8.3) file name: “FONTME~1”.
The “FontMetrics” directory should be located in: “C:\usr\cgtech3x\hhelp\xprinter\FontMetrics”
where “C:\usr\cgtech3x” is where CGTech products are installed.

Solution: if the “FontMetrics”, or “FONTME~1” directories do not exist- delete existing CGTech
software and re-install per the instructions in this manual.

If the “FONTME~1” directory exists- in a DOS window type “rename FONTME~1 FontMetrics”.

Can’t talk to lmgrd

See "Cannot connect to license server ... Connection refused (-15,8)".

... cgtechd.log not removed: Permission denied

See "Cannot connect to license server (-15,12:146) Connection refused (-15)".

... cgtechd.log: Cannot create

See "Cannot connect to license server (-15,12:146) Connection refused (-15)".

cgtech_lmgrd - Unable to Locate DLL
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See "The dynamic link library LMGR324A.DLL could not be found in the specified path".

CGTECHSW.EXE - Entry Point Not Found

See "The procedure entry point adjust_fdiv could not be located in the Dynamic Link Library
MSVCRT20.DLL".

(CGTech) ...

Ignore this text, then locate the remaining error message.

Check the contents of the vericut.log file...

Problem: licensing problems prevent VERICUT from being executed.

This general error message is followed by additional error messages which more accurately
describe the problem. Also, view the “cgtechd.log” located in the “license” directory for
additional error messages that may appear.

Clock difference too large between client and server (-34,119) (-34)

Problem: request for licensing to run CGTech products is made to a floating license server from a
client computer which differs in time (or time zones) by more than 30 minutes from that of the
license server computer.

Solution: set the client computer time clock so that it is within 30 minutes from that of the license
server computer and in the same time zone.

cnlsmgr.usr.exe entry point not found ...

Problem: a Window NT “Service” is installed to auto-start the license server, but the “cgtech.lf”
license file has not been copied to “C:\flexlm\license.dat”.

Solution: create a valid “cgtech.lf” license file (if not already done), then copy this file from the
“license”directory to “C:\flexlm\license.dat”. Reboot the computer.

See also "The procedure entry point_job could not be located in the Dynamic Link Library
MSVCRT20.DLL".

Command not found

Problem: the file executed does not exist.

Solution: verify that the typed name of the file is correct, and/or the directory path leading the file
is correct.

Connection refused

Note the entire error message, then see one of the following error messages:

- Cannot connect to license server ... Connection refused (-15)

- Cannot connect to license server ... Connection refused (-15,8)

- Cannot connect to license server (-15,12:61) Connection refused
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- Cannot connect to license server (-15,12:146) Connection refused (-15)

- Cannot connect to license server ... WinSock error code (-15)

- Cannot connect to license server [-15,11:10060] ... WinSock error code

Could not allocate color cells in the color map

Problem: CGTech product requiring 256 color display executed on a Windows computer having
the desktop configured with something other than 256 colors.

Solution: configure the desktop to 256 colors and retry, or obtain V3.2.4 or higher CGTech
software to support “true color” display.

Problem: CGTech product or Help executed on a workstation having a default number of color
cells less than 256 cells.

Solution: set the number of color cells for all windows to be 256, or obtain V3.2.4 or higher
CGTech software to support “true color” display.

Problem: CGTech product or Help executed in pseudo-color display mode when the root window
is configured with true color display, or the reverse is true.

Solution: ensure the root window is configured with the same display (pseudo-color vs. true color)
as the window in which CGTech products are executed, or obtain V3.2.4 or higher CGTech
software to support “true color” display.

Could not find OpenGL Visual...

Problem: VERICUT executed with the “opengl” command line option on a computer that does
not have Open/GL display capability, or computer that does not yet have support for Open/GL
display. When this error occurs, VERICUT uses the standard “X” display mode instead.

Solution: ensure that the computer is supported by CGTech for Open/GL display capability.
Consult the CD booklet or "VERICUT System Requirements" for details about computers on
which VERICUT can be operated in Open/GL display mode. If supported, ensure that the
Open/GL hardware and software are installed and operational.

could not initialize CNLS connection!

See "Cannot find License file (-1,73:2) No such file or directory".

CreateProcess error code: 0x2

Problem: the “cgtech.lf” license file specifies incorrect full path to the “CGTech” license server
daemon (second line of the file). This problem typically occurs when an old “cgtech.lf” license
file has been copied to a new “license” directory.

Solution: edit the second line of the license file to specify the correct path to the “CGTech”
license server daemon, then try to start the license server again.

CreateProcess error code: 0x3

Problem: the “cgtech.lf” license file was created for the wrong computer type.

Solution: access the CGTech License Manager window and change the Computer Type per the
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license information, then create and test a new license file. If necessary, start the license server.

Problem: VERICUT has been installed via connecting to a network drive that is not currently
available.

Solution: re-connect the network drive, then retry.

CreateProcess error code: 0x7b

Same as "CreateProcess error code: 0x2".

Current serial number in output stream: 59

See "X Error of failed request: BadAccess (attempt to access private resource denied)".

DENIED: ...

Problem: all available licenses for requested CGTech product/option have been checked out.

Solution: contact your CGTech representative for information about obtaining additional CGTech
product licenses.

Dr. Watson for Windows NT An application error has occurred

If this error occured when attempting to install VERICUT via File, Run: instead, open a DOS
window and execute the installation program.

If this error occurs when attempting to run VERICUT: see also "Unable to access USER
directory".

Problem: FX!32 on an Alpha NT computer is attempting to run the CGTech License Manager
program as an INTEL application.

Solution: configure FX!32 to not run CGTech applications (ref. Technical Bulletin #304)- from
Taskbar select: Start>Programs>FX!32>Manager. In the FX!32 Manager window, press
Options, Preference, Advanced... In Run Time Options window, add all CGTech products to the
list, then press OK.

eBadXPPATH: Bad value for XPPATH (...)

Problem: this error occurs when attempting to access Help documentation and the “FontMetrics”
directory does not exist, or has been renamed to the DOS short (8.3) file name: “FONTME~1”.
The “FontMetrics” directory should be located in: “C:\usr\cgtech3x\hhelp\xprinter\FontMetrics”
where “C:\usr\cgtech3x” is where CGTech products are installed.

Solution: if the “FontMetrics”, or “FONTME~1” directories do not exist- delete existing CGTech
software and re-install per the instructions in this manual.

If the “FONTME~1” directory exists- in a DOS window type “rename FONTME~1 FontMetrics”.

encryption code in license file is inconsistent

See "inconsistent encryption code for ...".

Error: or ERROR:
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Ignore this text, then locate the remaining error message.

error data is: .../vericut.opengl

See "System error - error data is: ...vericut.opengl".

Error In Password Data

Problem: the password data entered in the CGTech License Manager window is incorrect.

Solution: access the CGTech License Manager window and re-enter the password data as shown
on the license information; valid characters are alphabet characters A-F and numbers 0-9. Then
create and test a new license file. If necessary, start the license server.

Exceed/SDK for Windows 95 V5.0.1-Setup Please specify the home directory for eXceed:

Problem: there is not enough environment space for CGTech products to be executed.

Solution: the installation program automatically modifies the system PATH variable to include
the directories in which CGTech products are installed. Doing so may require more environment
space than available. Edit the CONFIG.SYS “SHELL” entry (or add one) to specify enough
environment space, for example: “SHELL=C:\COMMAND.COM C:\ /P /E:2048“. Reboot the
computer.

Exception: access violation (0x0000005), Address: 0x77f32d5e

See "Unable to access USER directory".

Fatal: or Fatal error:

Ignore this text, then locate the remaining error message.

Feature has expired (-10,32) (-10)

Problem: expiration date for the license file feature is incorrect or expired.

Solution: if expiration date was entered incorrectly- access the CGTech License Manager and re-
enter the Expiration date, then create and test a new license file. If necessary, start the license
server.

If the expiration date is expired- contact your CGTech representative for assistance.

feature not yet available

Problem: license server computer has a time/date setting that is prior to the date when the
CGTech supplied license information was created.

Solution: set the license server computer to the correct time/date.

FEATURESET incorrect in license file

Problem: the Feature Set password, or other password data is incorrect.

Solution: access the CGTech License Manager Window and re-enter the Feature Set password (or
other invalid password data); valid characters are alphabet characters A-F and numbers 0-9.
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Then create and test a new license file. If necessary, start the license server.

FEATURE start date is in future (-31,34) (-31)

Problem: license server computer has a time/date setting that is prior to the date when the
CGTech supplied license information was created.

Solution: set the license server computer to the correct time/date.

File creation error

If error occurs at CGTech license server start-up- see "Access denied File creation error".

If error occurs at boot-up- Problem: the SHELL line in the “config.sys” file is probably incorrect.

Solution: ensure the “SHELL” line in “config.sys” specifies enough environment space for
CGTech products to be operated, for example: “SHELL=C:\COMMAND.COM C:\ /P /E:2048”.

FLEXlm Error:

Ignore this text, then locate the remaining error message.

inconsistent encryption code for ...

When error appears in V3.4 for computer features (e.g. FEATURE VERICUT.HP, VERICUT.RS, etc.):

Problem: licensing originally shipped with V3.4 is invalid.

Solution: contact CGTech for valid V3.4 licensing.

When error appears for ALL licensed features:

Problem: company name (or ID in V3.4 or later licensing) in license file is incorrect.

Solution: access the CGTech License Manager to re-enter the Company Name (or ID) as shown
on the license information, then create and test a new license file. If necessary, start the license
server.

Problem: license expiration, or expiration date in license file is incorrect.

Solution: access the CGTech License Manager window and choose the correct License Expiration
and/or enter the correct Expiration date, then create and test a new license file. If necessary, start
the license server.

Problem: license server type is incorrect.

Solution: access the CGTech License Manager window and choose the correct License Server
type, then create and test a new license file. If necessary, start the license server.

Problem: computer type(s) not incorrect.

Solution: access the CGTech License Manager window and choose ALL licensed Computer
Types (even if software installed for only one or some of the licensed computer types), then
create and test a new license file. If necessary, start the license server.

Problem: an obsolete version of license information was used to generate a newer version license
file, or an obsolete (wrong version) “cgtech.lf” license file was referenced by a newer version
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license server.

Solution: obtain a current version of CGTech license information and use the correct version of
the CGTech License Manager to create and test a new license file. If necessary, start the license
server.

If none of the above solutions work, then delete and re-create the license file.

When error appears for 1 or some of the license file features:

Problem: license quantity is incorrect for each listed feature.

Solution: access the CGTech License Manager window and enter the correct Qty of licenses for
each listed option, then create and test a new license file. If necessary, start the license server.

inconsistent key ... or inconsistent license key ...

See "inconsistent encryption code for ...".

insmgr.sol is not available for platform solaris!

Problem: wrong shell type being used to install VERICUT.

Solution: switch to a UNIX Bourne shell, for example type: “/bin/sh”. Edit the PATH variable to
include “/usr/ucb” at the beginning of the path (e.g. PATH=/usr/ucb:$PATH), then type “export
PATH”. Change directories to “/cdrom/cgtech” and re-start the installation program per the
instructions in the CD booklet.

Invalid CGTech Daemon filename: ...CGTech in the license file: ...cgtech.lf

Problem: CGTech product executed when the license server is not running.

Solution: start the license server before attempting to operate VERICUT. It is recommended to
automate the license server start, as described under Automate starting a Windows CGTech
license server 8. or Automate starting a UNIX CGTech license server 6., whichever applies.

Invalid Feature Set

Problem: the Feature Set password, or other password data is incorrect.

Solution: access the CGTech License Manager window and re-enter the Feature Set password (or
any other invalid passwords); valid characters are alphabet characters A-F and numbers 0-9.
Then create and test a new license file. If necessary, start the license server.

Problem: computer type(s) not incorrect.

Solution: access the CGTech License Manager window and choose ALL licensed Computer
Types (even if software installed for only one or some of the licensed computer types), then
create and test a new license file. If necessary, start the license server.

If none of the above solutions work, then delete and re-create the license file.

Invalid host (-9,57:2) No such file or directory (-9)

Problem: normal users on HP computers can not run CGTech products, however, the products
can be run when logged in as root or a super user. This condition indicates that the “/dev/lan0”
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network file does not have read/write access to normal users.

Solution: log in to the server as “root”, change the access permissions on this file via typing
“chmod 666 /dev/lan0”.

Invalid host ...

Problem: HP computers with operating system HP-UX 9.x- normal users can not run CGTech
products, however, the products can be run when logged in as root or a super user. This
condition indicates that the “/dev/lan0” network file does not have read/write access to normal
users.

Solution: log in to the server as “root”, change the access permissions on this file via typing
“chmod 666 /dev/lan0”.

Problem: the required network card, or network software is not installed.

Solution: see "Windows pre-installation procedure" in the Installation chapter. After installing the
required network software, access the CGTech License Manager to create and test a valid
license file. Then try to start the license server again.

Problem: the required network software is installed, but TCP/IP does not have a valid IP address
bound to the network interface card.

Solution: assign an IP address and bind to network interface card via TCP/IP protocol software,
then try to start the license server again.

Problem: the required network software is installed, but has conflicts with other system resources.

Solution: resolve all resource conflicts, then try to start the license server again.

Problem: hostID in license file is incorrect.

Solution: determine the true hostID, as described under "Identify a Windows computer machine
ID" or "Identify a UNIX computer machine ID" in the Installation chapter. Also ensure that a
valid hostname is detected by the CGTech License Manager when creating the license file.

If the license information is correct but the data has been entered incorrectly, use the CGTech
License Manager to correct the HostID. Create and test a new license file. Then try to start the
license server again.

If the license information is incorrect for the desired licensed computer, complete and submit a
VERICUT License Request Form which identifies the desired license server computer.

Problem: hostname is not assigned to the CGTech license server computer. Check the appropriate
network file for valid host name-IP address assignment:

UNIX- /etc/hosts

Windows 95/98- C:\windows\hosts

Windows NT 3.51- C:\winnt35\system32\drivers\etc\hosts

Windows NT 4.0- C:\winnt\system32\drivers\etc\hosts

Solution: edit the license server (and clients) network file to specify all computers to be
communicated with, especially the CGTech license server computer. Consult the computer
networking documentation for details about assigning a valid host name prior to attempting to
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run a CGTech product or license server. Use the “ping” command to verify that the computers
can communicate over the network.

Problem: the “cgtech.lf” license file was created on a UNIX system and copied to a Windows
license server or client, or vice versa.

Solution: re-format the license file for use on a Windows computer for before copying (e.g.:
“unix2dos cgtech.lf”). Similarly, for use on a UNIX computer re-format the license file (e.g.:
“dos2unix cgtech.lf”). If the dos2unix command is not available, then load the cgtech.lf file into
the “vi” editor and enter the following command: 1,$s/^V^M//g <Return>.

Invalid license key ...

See "inconsistent encryption code for ...".

Invalid ... Password

Problem: the password data entered in the CGTech License Manager window is incorrect.

Solution: re-enter the password data as shown on the license information; valid characters are
alphabet characters A-F and numbers 0-9. Then create and test a new license file. If necessary,
start the license server.

Invalid returned data from license server(-12,122)

Problem: license server and client computer(s) are not aware of each other. Check the appropriate
network file for valid host name-IP address assignment:

UNIX- /etc/hosts

Windows 95/98- C:\windows\hosts

Windows NT 3.51- C:\winnt35\system32\drivers\etc\hosts

Windows NT 4.0- C:\winnt\system32\drivers\etc\hosts

Solution: edit the license server (and clients) network file to specify all computers to be
communicated with, especially the CGTech license server computer. Consult the computer
networking documentation for details about assigning a valid host name prior to attempting to
operate VERICUT or the license server. Use the “ping” command to verify that the computers
can communicate over the network.

Ld.so.1: ...cnlsmgr.user :fatal :libXm.so.2:can’t openfile error=2 killed

Problem: V3.0-3.3 “makelf” program executed on Sun/Solaris was unsuccessful accessing the
required “dynamic” X-Motif ibrary files.

Solution: the required “dynamic” X-Motif library files are typically located in “/usr/dt/lib”. By
default, these files are installed on all Sun/Solaris 2.5 or higher computers, however, are
optional on 2.3-2.4 versions of Solaris. Ensure that these files exist and have read access to all
users.

It is also possible that the required X-Motif ibrary files are named differently. “libXm.so” may
exist instead of “libXm.so.2”. In these cases, try creating a UNIX link having the name of the
file referenced in the error message. For example (as root):
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- cd /usr/dt/lib

- create the link: "ln -s libXm.so libXm.so.2"

Ld.so.1: ...cnlsmgr.user :fatal :libXtso 4 :can’t openfile error=2 killed

Problem: the “makelf” program executed on Sun/Solaris was unsuccessful accessing the required
“dynamic” X-Motif ibrary files.

Solution: the required “dynamic” X-Motif library files are typically located in “/usr/dt/lib”. By
default, these files are installed on all Sun/Solaris 2.5 or higher computers, however, are
optional on 2.3-2.4 versions of Solaris. Ensure that these files exist and have read access to all
users.

Problem: the “makelf” program was unsuccessful accessing the required Open Windows Library
files.

Solution: set the LD_LIBRARY_PATH environment variable, for example type “setenv
LD_LIBRARY_PATH “/usr/openwin/lib:/usr/lib”. If the environment variable has been set but
the problem persists, then it may be that the Open Windows Library has been moved to a
location other than expected. Replace the “/usr/openwin/lib” portion of the above command
specify the correct path to the Open Windows Library files.

Ld.so.1: ...machsim.opengl :fatal :libGL.so :can’t openfile errno=2 killed

Same as "Ld.so.1: ...vericut.opengl :fatal :libGL.so :can’t openfile errno=2 killed".

Ld.so.1: ...vericut.opengl :fatal :libGL.so :can’t openfile errno=2 killed

Problem: VERICUT executed with the “opengl” command line option on a Sun Solaris computer
that does not have Open/GL display capability.

Solution: ensure that the Open/GL hardware and software are installed and operational (ref. Check
for correct version of operating & window systems under UNIX System Requirements & Pre-
installation Procedure 2-1):

� Verify the “libGL.so” library file exists (typically located in “/usr/openwin/lib” with other “libGL”
files) and has permissions for user access. The UNIX “find” command may help locate this file:
“find / -name "libGL*" -print”.

� Verify the Creator Graphics device driver is installed to support the required Creator 3D graphics
card. Type “pkginfo | grep Creator” and look for “Creator Graphics (FFB) System Software
(Device Driver)”, for example:

system      SUNWffb        Creator Graphics (FFB) System Software
(Device Driver) ---
application SUNWffbcf      Creator Graphics (FFB) Configuration Software
application SUNWffbw       Creator Graphics (FFB) Window System Support
application SUNWffbxg      Creator Graphics (FFB) XGL Support

� Verify that OpenGL Runtime libraries are installed. Type “pkginfo | grep OpenGL” and look for
“OpenGL Runtime Libraries” with other OpenGL support items, for example:

application SUNWgldoc      OpenGL Documentation and Man Pages
application SUNWglh        OpenGL Header Files
application SUNWglrt       OpenGL Runtime Libraries ---
application SUNWglut       OpenGL Utilities and Example Programs
application SUNWglwh       OpenGL Widget Header Files
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application SUNWglwrt      OpenGL Widget Library

� Verify that the GLX windows extension is installed. Type “xdpyinfo” and look under “number of
extensions” for “GLX”.

If the Creator Graphics device driver, OpenGL Runtime libraries, or GLX extension are not
detected, they must be installed before running under OpenGL.

License Check-out Failed

Problem: licensing problems prevent the license file from testing successfully.

Look for other error messages which indicate the licensing problem. See the “cgtechd.log” located
in the “license” directory”, or other locations where error messages may appear as described
under "Where to look for error messages" in this chapter.

license daemon: execl failed: ...

See "license daemon: system error code: No such file or directory".

License Daemon NOT Started

Problem: the license daemon “cgtech_lmgrd” did not start successfully.

Consult the “cgtechd.log” file in the “license” directory for error descriptions.

License daemon startup failed: ...

Note the entire error message, then see one of the following messages:

- CreateProcess error code: 0x2

- CreateProcess error code: 0x3

- CreateProcess error code: 0x7b

license daemon: system error code: No such file or directory

Problem: there is an incorrect path name to the “CGTech” license server daemon (specified in the
second line of the “cgtech.lf” license file).

Solution: edit the second line of the license file to specify the correct full path name to the
“CGTech” license server daemon, then try to start the license server again.

License file does not support this version (-21,126) (-21)

Problem: an obsolete version of license information was used to generate a newer version license
file, or an obsolete (wrong version) “cgtech.lf” license file was referenced by a newer version
license server.

Solution: obtain a current version of CGTech license information and use the correct version of
the CGTech License Manager to create and test a new license file. If necessary, start the license
server.

Problem: a CGTECH_LF environment variable is defined pointing to an obsolete (wrong version)
“cgtech.lf” license file.
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Solution: CGTech command files automatically establish this environment variable. Unset the
currently defined CGTECH_LF environment variable, then re-execute the CGTech product.

license manager: can’t initialize:

Note the entire error message, then see one of the following messages:

- Cannot find License file (-1,73:2) No such file or directory

- No SERVER lines in License file

license no longer available

Problem: VERICUT is running when the license server has failed.

Solution: exit VERICUT, or start the license server and resume VERICUT operation (e.g. press
"Play" to continue cutting).

license not available

Problem: the CGTech product does not have a license available. All available licenses for the
product have been checked out, or a license for the product does not exist in the “cgtech.lf”
license file.

Solution: contact your CGTech representative for information about obtaining additional CGTech
product licenses.

Problem: VERICUT is running when the license server has failed.

Solution: exit VERICUT, or start the license server and resume VERICUT operation (e.g. press
"Play" to continue cutting).

Problem: other licensing problems prevent the CGTech product from being executed. See the
“cgtechd.log” located in the “license” directory”, or other locations where error messages may
appear as described under "Where to look for error messages" in this section.

license not available for this platform

Problem: the CGTech product does not have a license for the computer type on which it has been
requested.

Solution: contact your CGTech representative for information about obtaining CGTech product
licenses for use on this computer type.

Problem: other licensing problems prevent the CGTech product from being executed.

See the “cgtechd.log” located in the “license” directory”, or other locations where error messages
may appear as described under "Where to look for error messages" in this section.

Licensed number of users already reached (-4,132) (-4)

Problem: all available licenses for a requested CGTech product/option have been checked out.

Solution: contact your CGTech representative for information about obtaining additional CGTech
product licenses.
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License server does not support this feature (-18,147) (-18)

Problem: attempted to create and use a license file for a new software version when an existing
version is licensed via an NT service.

Solution: stop the existing license server via the existing version CGTech “Stop Server” program,
then run the “Remove Service” program to remove the NT service fot the existing version. Test
the new version license file, and if necessary start the new license server.

(lmgrd) ...

Ignore this text, then locate the remaining error message.

locale not supported by Xlib, locale set to C

Problem: the current verison of Exceed is not compatible with the version of VERICUT being
executed.

Solution: re-install VERICUT and answer “Yes” to the prompt for installing Exceed when an
existing verison is detected.

MACHINE SIMULATION license no longer available

See "license no longer available".

MACHINE SIMULATION license not available!

See "license not available".

MACHINE SIMULATION license not available for this platform!

See "license not available for this platform".

Machine Simulation requires that the X server supply an 8 bit color map in order for Machine
Simulation to render images.

See "VERICUT requires that the X server supply an 8 bit color map in order for VERICUT to
render images".

Machine Simulation resource file not found - exiting

See "resource file not found - exiting".

Major opcode of failed request: 89 (X_StoreColors)

See "X Error of failed request: BadAccess (attempt to access private resource denied)".

No FLEXlm nodes found to shut down: Cannot connect to license server (-15,12:61) Connection
refused

See "Cannot connect to license server (-15,12:61) Connection refused".

No FLEXlm nodes found to shut down: Cannot find SERVER hostname in network database (-
14,7:11004) WinSock error code
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See "Cannot find SERVER hostname in network database (-14,7:11004) WinSock error code".

No room for font 6x13

See "Can’t open default font".

No SERVER lines in License file

Problem: server stop attempted on a “Demo” license server.

Solution: do not attempt to stop this type of license server as a server process is not running.

Problem: the “SERVER” line (typically the first line in the “cgtech.lf” license file) is missing.

Solution: access the CGTech License Manager window and enter the HostID as shown on the
CGTech License Information. Also ensure that a valid hostname is detected by the CGTech
License Manager. Create and test a new license file, then try to start the license server again.

No such feature exists (-5,116) (-5)

Problem: error appears when older CGTech product version is run but not running newer version:
CGTech product licensing changed in the newer version and by default does not support
operation of the older version.

Solution: contact your CGTech representative for information about obtaining “compatibility
license” to support the older version product.

Problem: the CGTech product does not have a license for the computer type on which it has been
requested, or does not have a license for the product at all.

Solution: contact your CGTech representative for information about obtaining additional CGTech
product licenses.

No such file or directory

Note the entire error message, then see one of the following messages:

- Cannot find License file (-1,73:2) No such file or directory

- Invalid host (-9,57:2) No such file or directory (-9)

Not a valid server hostname, exiting.

Problem: HP computers with operating system HP-UX 9.x- normal users can not run CGTech
products, however, the products can be run when logged in as root or a super user. This
condition indicates that the “/dev/lan0” network file does not have read/write access to normal
users.

Solution: log in to the server as “root”, change the access permissions on this file via typing
“chmod 666 /dev/lan0”.

Problem: hostname in the license file is incorrect.

Solution: ensure that a valid hostname is detected by the CGTech License Manager when creating
the license file.
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If the Hostname has been edited, access the CGTech License Manager window to re-read the
Hostname, then try to start the license server again.

If the license information is incorrect for the desired licensed computer, complete and submit a
VERICUT License Request Form which identifies the desired license server computer.

Out of environment space

Problem: not enough environment space is available for CGTech products to be executed.

Solution: add a “SHELL” line to the “config.sys” file specifying enough environment space for
CGTech products to be operated, for example “SHELL=C:\COMMAND.COM C:\ /P /E:2048”.

Problem: Pre-V3.3 systems only: the steps below can also be used to override the CONFIG.SYS
“SHELL” environment space setting on a per program basis (the V3.2 “CGTechsw” program is
used as an example).

To override the CONFIG.SYS “SHELL” environment space setting on a per program basis:

- Use Explorer to open the directory where CGTech command files are located, typically
"win...\commands" or "windows\commands".

- Right-click on the command file to change the environment space setting.

- From the menu that opens, choose Properties.

- Click the Memory tab.

- Set Initial environment: 2048 (or higher), click OK.

- Rerun (double click) the command file.

- Repeat the above procedure on all remaining command file (.bat) in the CGTech Software
program group.

Permission denied.

Problem: file can not be accessed by the current user to perform the requested operation.

Solution: change file access permissions to allow user access.

Please correct problem and restart daemons

Note the entire error message, then see one of the following messages:

- Wrong hostid, exiting (expected ..., got 80000000)

- Wrong hostid, exiting (expected ..., got 000000000000)

- Wrong hostid, exiting (expected ..., got 204c4f4f5020)

- Wrong hostid, exiting (expected ..., got ffffffff)

- Wrong hostid, exiting (expected ..., got ffffffffffff)

- Wrong hostid, exiting (expected ..., got ...)

Please specify the home directory for eXceed.
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See "Out of environment space".

Please verify your License file with your VERICUT representative.

See "Invalid Feature Set".

Problems with allocating color map and/or cells

See "Could not allocate color cells in the color map".

Process fork failed

Problem: the computer’s local memory has been exhausted.

Solution: exit all unused applications and close unused windows to free system resources, then
retry. If the condition persists exit from all CGTech products and reboot the computer.

Product is not installed on this platform!

Problem: the CGTech product does not have an executable for the computer type on which it has
been requested.

Solution: if the License Information shows the desired product is licensed for use on the desired
platform- ensure that the product has been installed as described by the installation
documentation.

If the product is not licensed- contact your CGTech representative for information about obtaining
CGTech products and licenses for use on additional computer platforms.

resource file not found - exiting

Problem: the CGTech software application as been executed directly, instead of using command
file to set proper environment variables and use the required resource file.

Solution: execute the application from the CGTech Software Manager, or via the corresponding
command file located in the “commands” directory.

Retrying socket bind (address in use: port ...)

See "socket bind: Address already in use".

REVPOST license not available!

See "license not available".

REVPOST license not available for this platform!

See "license not available for this platform".

RevPost II requires that the X server supply an 8 bit color map in order for RevPost II to render
images.

See "VERICUT requires that the X server supply an 8 bit color map in order for VERICUT to
render images".
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RevPost II resource file not found - exiting

See "resource file not found - exiting".

sbin/loader fatal error

See "this executable has unresolved symbols".

Serial number of failed request: 58

See "X Error of failed request: BadAccess (attempt to access private resource denied)".

server_connect to ... failed:

Problem: server start attempt failed.

This general error message is followed by additional error messages which more accurately
describe the problem. Consult the secondary error message in this section for the
problem/solution related to the above error message.

SET ACCESS NOT ALLOWED

Problem: the directory from which CATV has been executed does not have “write” permissions
for the current user.

Solution: exit the CATIA/CATV session, change directories to one that files can be written to,
then re-execute CATIA/CATV.

socket bind: Address already in use

Problem: license server start attempted when a CGTech license server is already running. Only
one CGTech license server may be running at a time.

Solution: Windows computers use the CGTech “Stop Server” program to stop the active license
server process, UNIX use the “stop_server” program in the “license” directory. Then try to start
the license server again.

Problem: the network socket address specified in the “cgtech.lf” license file (typically “1700”) is
currently in use by another product’s license server.

Solution: access the CGTech License Manager window and edit the socket address (e.g. change
“1700” to “1701”), then try to start the license server again.

socket bind (address in use: port 1700)

See "socket bind: Address already in use".

socket call failed (-57,17:10047) Winsock error code

Problem: the required network card, or network software is not installed.

See "Windows pre-installation procedure" in the Installation chapter. After installing the required
network software, access the CGTech License Manager to create and test a valid license file.
Then try to start the license server again.
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socket call failed (-57,17:10047) Winsock error code (-57)

See "socket call failed (-57,17:10047) Winsock error code".

socket call failed (-57,17:10055) Winsock error code

Problem: the network card is not secure and has lost connection (came loose).

Solution: shutdown the system, re-install the network card, then re-boot the system. Verify that all
required network software is operational. If necessary, start the license server.

Symbol_mod_init in ksh is not defined

See "System error - error data is: ...vericut.opengl".

System error - error data is: ...vericut.opengl

Problem: VERICUT executed with the “opengl” command line option on a computer that does
not have Open/GL display capability, or computer that does not yet have support for Open/GL
display.

Solution: ensure that the computer is supported by CGTech for Open/GL display capability.
Consult the CD booklet or "VERICUT System Requirements" for details about computers on
which VERICUT can be operated in Open/GL display mode. If supported, ensure that the
Open/GL hardware and software are installed and operational.

The application failed to initialize properly

See "The procedure entry point adjust_fdiv could not be located in the Dynamic Link Library
MSVCRT20.DLL".

The dynamic link library LMGR324A.DLL could not be found in the specified path

Problem: the CGTech “Install Service” program has been executed before Windows NT has been
configured to support the service.

Solution: use the CGTech “Remove Service” to remove the NT Service, then configure Windows
NT as described under Automate starting a Windows CGTech license server 8..

Problem: the LMGR324A.DLL file has been moved from the CGTech “commands” directory.

Solution: return a copy of this file to the “commands” directory, or uninstall & reinstall CGTech
software.

The dynamic link library LMGR325C.DLL could not be found in the specified path..

See "The dynamic link library LMGR324A.DLL could not be found in the specified path".

The environment variable CGTECH_LF is not defined.

Problem: VERICUT has been executed via the executable file instead of the command file.

Solution: execute CGTech products via the CGTech Software Manager, or via the corresponding
command script file stored in the “commands” directory.
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The environment variable CGTECH_VCHOME is not set!

Problem: VERICUT has been executed via typing the executable name.

Solution: execute CGTech products via the CGTech Software Manager, or via the corresponding
command script stored in the “commands” directory.

The name specified is not recognized as an internal or external command, operable program, or
batch file

Problem: the CGTech product (or other application) does not exist, or has been renamed to the
DOS short (8.3) version of the file name.

Solution: if the CGTech product does not exist- install the product per the instructions in this
manual.

If the CGTech product does exist- in a DOS window rename the file to its long version of the file
name. If you are unsure of the exact file name, contact CGTech Technical Support for
assistance.

The procedure entry point adjust_fdiv could not be located in the Dynamic Link Library
MSVCRT20.DLL

Problem: an obsolete “MSVCRT20.DLL” file exists on Windows NT, typically located in the
“C:\windows\system32” directory.

Solution: rename, or delete the existing “MSVCRT20.DLL” file from the “system32” directory,
delete any VERICUT software that has been installed, then reinstall.

The procedure entry point_job could not be located in the Dynamic Link Library MSVCRT20.DLL

Problem: there are two files having the name “cnlsmgr.usr.exe”.

Solution: the CGTech “cnlsmgr.usr.exe” file is located in the “license” directory. Find the other
file having this name (typically located in “C:\winnt35\system32”), rename it, then re-test the
license file.

The process cannot access the file because it is being used by another process.

Problem: license server start attempted when a CGTech license server is already running. Only
one CGTech license server may be running at a time.

Solution: Windows computers use the CGTech “Stop Server” program to stop the active license
server process, UNIX use the “stop_server” program in the “license” directory. Then try to start
the license server again.

Problem: the network socket address specified in the “cgtech.lf” license file (typically “1700”) is
currently in use by another license server.

Solution: access the CGTech License Manager window and edit the socket address (e.g. change
“1700” to “1701”). Then try to start the license server again.

The system has detected a conflict for the IP address ...

Problem: the IP address specified for use with TCP/IP is already used by other network software.
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Solution: specify a unique IP address for use with TCP/IP, for example: 199.1.1.1, 199.1.1.2, etc.
Consult the operating system documentation for information about assigning IP addresses. Use
the “ping” command to verify that the computers can communicate over the network.

This DHCP client was unable to obtain an IP network address from a DHCP server.

Problem: TCP/IP has been installed without a valid IP address bound to the network interface
card.

Solution: assign IP address and bind to network interface card via TCP/IP protocol software.

this executable has unresolved symbols

Problem: current executable is incompatible with DEC/Alpha 4.0 operating system.

Solution: upgrade to V3.3.1 or higher, or contact CGTech Technical Support about obtaining
updated executables for this operating system (ref. Technical Bulletin #300).

Unable to access USER directory

Problem: VERICUT V3.3.1 no longer runs on Windows NT 4.0 after V3.3 has been uninstalled.
Deletion of V3.3 deleted some of the Registry entries required to operate V3.3.1 software.

Solution: restore the entries in the Registry required by VERICUT V3.3.1 (ref. Technical Bulletin
#303):

To restore the entries in the Registry required by VERICUT V3.3.1:

- Log in to NT as “Administrator”

- From Taskbar select: Start>Run

- In the Run window, Open=regedit, press OK

- In Registry Editor window, open folders: HKEY_USERS, DEFAULT, Software, HummingBird,
Exceed

Text entries in the steps below are case sensitive!

- Select Edit menu, New>String Value

- Edit string value “New Value #1” to be “HomeDir” <cr>

- With HomeDir highlighted select Edit menu, Modify

- Enter Value data=C:\cgtech331\win_nt\exceed (“C:\cgtech331” is where CGTech products are
installed)

- Select Edit menu, New>String Value

- Edit string value “New Value #1” to be “UserDir” <cr>

- With UserDir highlighted select Edit menu, Modify

- Enter Value data=C:\cgtech331\win_nt\exceed\user

- Exit the Registry Editor
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Problem: normal Windows NT 3.51 user is unable to access VERICUT V3.0 installed by
“Administrator”, however, Administrator is able to run.

Solution: follow the steps below to edit the Registry to allow all users to access VERICUT.

To edit the Registry to allow all users to access VERICUT:

- Log in to NT as “Administrator”

- From the Program Manager, select File>Run

- In the Run window, Command Line=regedt32, press OK

Text entries in the steps below are case sensitive!

- In HKEY_USERS on Local Machine window, expand (double-click) HKEY_USERS,
DEFAULT, Software

- Registry Editor window, select Edit>Add Key

- Key Name=Hummingbird, Class=(blank), OK

- In HKEY_USERS on Local Machine window, highlight Hummingbird

- Registry Editor window, select Edit>Add Key

- Key Name=eXceed, Class=(blank), OK

- In HKEY_USERS on Local Machine window, highlight eXceed

- In Registry Editor window, select Edit>Add Value

- Value Name=HomeDir, Date Type=REG_SZ, OK

- String Value=C:\usr\cgtech\exceed, OK (“C:\usr\cgtech” is where CGTech products are
installed)

- In Registry Editor window, select Edit>Add Value

- Value Name=UserDir, Date Type=REG_SZ, OK

- String Value=C:\usr\cgtech\exceed\user, OK

- In Registry Editor window, select Edit>Add Value

- Value Name=Version, Date Type=REG_SZ, OK

- String Value=4.1.1, OK

- Exit the Registry Editor

unable to check out feature ...

Problem: the license server can not grant the request for the CGTech product/option.

This general error message is followed by additional error messages which more accurately
describe the problem. Consult the secondary error message(s) for problem descriptions and
solutions related to the above error message.
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Unable to execute program due to date conflicts.

Problem: the computer’s time/date clock has been set backward. The licensing software can
detect this condition even when the date is reset to be the correct time/date.

Contact CGTech Technical Support for assistance.

Unable to execute program due to invalid FEATURESET.

See "Invalid Feature Set".

Unable to execute program due to invalid or missing license file.

Problem: a license for the current computer type on which the CGTech product has been executed
does not exist in the license file.

Solution: contact your CGTech representative for information about obtaining additional CGTech
product licenses.

Problem: the “BASE” license feature is missing in the “cgtech.lf” license file.

Solution: access the CGTech License Manager to ensure that the VERICUT “BASE” option has
been toggled. Create and test a new license file, then try to start the license server again.

Unable to execute program due to missing FEATURESET.

Problem: the FEATURESET entry is missing from the “cgtech.lf” license file. The
FEATURESET entry should be the last line in the file.

Solution: use the CGTech License Manager to create and test a new license file, then try to start
the license server again.

Unable to locate DLL

See "The dynamic link library LMGR324A.DLL could not be found in the specified path".

Unknown host: ...

Problem: TCP/IP is installed, but does not have a valid IP address bound to the network interface
card.

Solution: assign IP address and bind to network interface card via TCP/IP protocol software, then
try to start the license server again.

Vendor daemon can’t talk to lmgrd (Cannot connect to license server)

Problem: server start attempted on DEC/Digital UNIX computer by someone who has switched
user to “root” via the “su” command.

Solution: log out, then log back in as “root” and re-start the license server.

Vendor daemon died with status 241

See "Vendor daemon can’t talk to lmgrd (Cannot connect to license server)".
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Vendor Daemon Log Empty ...cgtechd.log

Problem: license server start attempted via a “start_server” command that does not have
“executable” access.

Solution: log in as “root” and retry, or change permissions on all CGTech executables to have
executable access, especially “start_server” and “cgtech_lmgrd” located in the “license”
directory. If other “executable access” related problems occur, it is recommended to delete the
current software installation, then re-install VERICUT as directed by the VERICUT Installation
Manual.

Vendor Daemon Log Not Found ...

Problem: license server start or license test attempted as normal user.

Solution: log in as “root” and retry.

Vendor Daemon NOT Started

Problem: the vendor daemon “Cgtech” did not start successfully.

Consult the “cgtechd.log” file in the “license” directory for error descriptions.

VERICUT license no longer available

See "license no longer available".

VERICUT license not available!

See "license not available".

VERICUT license not available for this platform!

See "license not available for this platform".

VERICUT requires that the X server supply an 8 bit color map in order for VERICUT to render
images

Problem: a version of VERICUT requiring 256 color display was executed on a Windows
computer having the desktop configured with something other than 256 colors.

Solution: reset the desktop to 256 colors, or obtain V3.2.4 or higher CGTech software to support
true color display.

Problem: the Windows 95/98 or NT color palette is set for more than 256 colors when the
CGTech product was executed in pseudo-color display mode.

Solution: execute the CGTech product in the true color display mode, or change the display to
support running the CGTech product in the desired color mode.

Vericut resource file not found - exiting

See "resource file not found - exiting".

Video driver does not support palette
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Problem: CGTech product requiring 256 color display executed on a Windows computer having a
video card configured to display in true color.

Solution: configure the video card and desktop to display in 256 colors, or obtain V3.2.4 or higher
CGTech software to support “true color” display.

Warning:

Ignore this text, then locate the remaining error message.

WinSock error code ...

Note the entire error message, then see one of the following messages:

- Cannot connect to license server ... WinSock error code (-15)

- Cannot connect to license server [-15,11:10060] ... WinSock error code

- Cannot find SERVER hostname in network database (-14,7:11004) WinSock error code

- socket call failed (-57,17:10047) Winsock error code

- socket call failed (-57,17:10055) Winsock error code

Wrong hostid, exiting (expected ..., got 80000000)

Problem: attempted to license a DEC Alpha VMS computer which the CGTech License Manager
can not communicate with.

Contact CGTech Technical Support for assistance.

Wrong hostid, exiting (expected ..., got 000000000000)

Problem: a SNMPAPI.DLL file is present in the “C:\WINNT\SYSTEM32” directory but the
SNMP service is not installed.

Solution: check the “C:\WINNT\SYSTEM32” directory for the presence of this file. If
SNMPAPI.DLL is present and the SNMP service is not installed, delete or rename this file, e.g.
“SNMPAPI.OLD”.

Wrong hostid, exiting (expected ..., got 204c4f4f5020)

Same as "Wrong hostid, exiting (expected ..., got ffffffff)".

Wrong hostid, exiting (expected ..., got ffffffff)

Problem: Windows network components are not detected or not functioning.

Solution: remove the network components, if installed, then re-install per the operating system
documentation. When installing TCP/IP be sure to assign an IP address and bind to the network
interface card via TCP/IP protocol software. Then try to start the license server again

Wrong hostid, exiting (expected ..., got ffffffffffff)

Same as "Wrong hostid, exiting (expected ..., got ffffffff)".
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Wrong hostid, exiting (expected ..., got ...)

Problem: HP computers with operating system HP-UX 9.x- normal users can not run CGTech
products, however, the products can be run when logged in as root or a super user. This
condition indicates that the “/dev/lan0” network file does not have read/write access to normal
users.

Solution: log in to the server as “root”, change the access permissions on this file via typing
“chmod 666 /dev/lan0”.

Problem: the expected hostID in license file is incorrect; the network card ID detected is the ID
following the “got” identifier.

Solution: determine the true hostID, as described under "Identify a Windows computer machine
ID" or "Identify a UNIX computer machine ID" in the Installation chapter. Also ensure that a
valid hostname is detected by the CGTech License Manager when creating the license file.

If the license information is correct but the data has been entered incorrectly, use the CGTech
License Manager to correct the HostID. Create and test a new license file. Then try to start the
license server again

If the license information is incorrect for the desired licensed computer, complete and submit a
VERICUT License Request Form which identifies the desired license server computer.

Problem: in remote cases, the license file has been corrupted by some unseen character(s).

Solution: access the CGTech License Manager to re-enter all license infromation, then create and
test a new license file. If necessary, start the license server.

X error failed request: Bad Access

See "Could not allocate color cells in the color map".

X error failed request: Bad name...

Problem: VERICUT was executed on a Sun computer with an OpenWindows 3.x window system
that does not contain the industry standard 8x13 font.

Solution: re-install OpenWindows 3.x with any configuration except “Minimal”, for example
choose a configuration such as: “End user”, “Advanced” or higher.

X Error of failed request: BadAccess (attempt to access private resource denied)

Problem: Help was accessed from a CGTech product when a Help viewer color was not available
in the color map.

Solution: access Help from the CGTech Software Manager, or resolve the condition by following
the steps below (ref. Technical Bulletin #302):

- Locate the file named “hhres” in the /cgtech3x/computertype/hhviewer directory where
“/cgtech3x” represents where CGTech software products have been installed and
“computertype” represents the computer on which CGTech products are operated. For example,
for an SGI computer on which V3.3 Help is being corrected look in “/cgtech33/sgi/hhviewer”.

- Edit all occurrences of the text “gray” in this file to be “gray75” (globally).
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- Save the edited file under the same “hhres” file name.

- Repeat the above steps for each different computer type (e.g. /cgtech33/rs/hhviewer, etc.).

X Toolkit Error: Cannot perform malloc

Problem: this error occurs when accessing a Help file having bookmarks or annotations that were
defined while using Help on a different computer type.

Solution: delete (or rename) the Help edit file corresponding to the Help file being accessed. An
edited Help file is stored in a “.hh” directory under the user’s login directory. For example, if
the error occurs when accessing the VERICUT User Manual (vericut.hlp), delete the
“.hh/vericut.hlpab” HyperHelp edit file. Then access the VERICUT Help again.
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Service - how to install, 17
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